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Chapter 1- About This Document

1. About This Document

11 Version Information

This document provides information for installing, operating, and maintaining IRIS Focus
software.

Table1 Document Versions

Document Code Date Description

M211850EN-E December 2017 This document. Fifth version of this document.
M211850EN-D February 2017 Fourth version of this document.
M211850EN-C June 2016 Third version of this document.

1.2 Related Documents

Table 2 Related Documents

Document Code | Name

M211850EN IRIS Focus Administrator Guide
M211849EN IRIS Focus User Guide
M211904EN IRIS Focus Release Notes

1.3 Trademarks

HydroCIassTM is a trademark of Vaisala Oyj.

IRIS™ is a trademark of Vaisala Oyj.

All other product or company names that may be mentioned in this publication are trade
names, trademarks, or registered trademarks of their respective owners.

1.4 Documentation Conventions

WARNING! Warning alerts you to a serious hazard. If you do not read and
follow instructions carefully at this point, there is a risk of injury or even death.

(O3]
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CAUTION! Caution warns you of a potential hazard. If you do not read and
| follow instructions carefully at this point, the product could be damaged or
important data could be lost.

0 Note highlights important information on using the product.
g Tip gives information for using the product more efficiently.
y Lists tools needed to perform the task.

@ Indicates that you need to take some notes during the task.
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2. IRIS Focus Overview

VAISALA /7 Focus

Figure1 IRIS Focus Main View

IRIS Focus provides user-friendly, browser-based tools for viewing and analyzing weather data
received from weather radars.

Weather data is overlaid on a geographical map that is centered on a selected radar site or site
composite. Data is gathered from a single weather radar or a network of radar sites.

With the zoomable animation timeline, users can easily visualize and animate current,
nowcasted, or historical data.

Nowecasting performs advection calculations on motion data from radar products to predict
weather movement and severity up to, for example, 2 hours in the future.

Significant weather events such as hail, wind shear, or heavy rain are automatically detected
when they enter a protected area.

Radar Products

The displayed data consists of radar products, which are raw signal data from a radar receiver
processed to provide information about current weather conditions.

Radar products measure information such as radar signal reflectivity or rain intensity for
analysis by meteorologists.
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Live Radar Products Live radar products are radar signal data that is processed into radar
products and displayed on-demand, in real-time.

Live products provide control over the presentation of weather data in
the IRIS Focus user interface. For example, users can change the
reflectivity threshold of a selected radar product on the fly.

IRIS Focus users can create composites of live products on-demand by
selecting multiple radar sites from the radar site selector.

Pre-configured Radar | Pre-configured products are defined and produced in IRIS Analysis and
Products displayed by IRIS Focus on request.

More Information

» Live Radar Products (page 84)
» Pre-configured Radar Products (page 86)

2.1 IRIS Product Family

IRIS Focus provides an intuitive user experience for professional users, such as meteorologists
and analysts. It is closely integrated with Vaisala weather radar systems, where IRIS Focus
forms the visualization front-end and other IRIS components handle radar control, radar
product generation, and data distribution. IRIS Focus retains the proven quality of Vaisala IRIS
back-end processing software, while adding a modern user interface.

IRIS Focus runs on a web server that users can connect to in an enterprise intranet or from an
external location or the Internet. Network connections between the IRIS Focus web Ul and the
data processing back-end go through a socket server, a custom protocol over TCP/IP that
delivers radar data from the IRIS back-end services to IRIS Focus. The IRIS Focus application
polls the server for data and displays it on screen.

The following figure shows a setup where IRIS Focus is used as part of a complete Vaisala
weather radar network consisting of 2 radar sites.

Data source Processing Visualization
)
|R|S /_ Data managerlRlS FOCUS
RAW / Analvsi
IRIS T::; nalysis Live [{7ippi,cappl Web Browser
product |[_! —= -
Radar1 \ T processor L{__ Controls ,(i);:\ j
Preconﬂg.i | Processed product pictures ' r= =
product | &} -
processor "\
\—/ Socket \

Figure 2 IRIS Focus Data Flow


http://www.vaisala.com/en/products/weatherradars/Pages/default.aspx
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In this case, IRIS Analysis and IRIS Radar can be considered back-end services for the IRIS
Focus front-end interface. IRIS Focus communicates with IRIS Analysis through a secure
socket server connection.

The components have the following functions:

* RIS Radar - Operates the radar site and stores data gathered from the radar signals in
RAW format.

* RIS Analysis - Receives RAW data from IRIS Radar through secure connection and
processes it into displayable radar products.

* [RIS Focus - Polls pre-configured radar products from IRIS Analysis and displays them on
the web interface and generates live radar products from RAW data.

2.2 Licensing

IRIS Focus requires a software license to run. To activate the license, you need a product key.

Vaisala delivers the product key when you purchase the software. If you have purchased the
software and you have not received the product key, please contact Vaisala.

For server deliveries, Vaisala activates the product key in the factory and a Vaisala
representative sends you the key for future reference.

The license is mapped to the hardware of your IRIS Focus server. If your hardware
configuration changes and you need to re-install IRIS Focus, you must request a replacement
license from your Vaisala representative.

License Options
The IRIS Focus license includes the following:

* IRIS Focus Light
IRIS Focus Light has an unlimited number of seats and provides access to the map view.
If the license is missing, users cannot log in while admins can log in but cannot access the
map view.

* IRIS Focus

The IRIS Focus license is required to use IRIS Focus features and products.

IRIS Focus licensing is based on a floating seat pool.

Nowcasting

The optional nowcasting feature requires a separate license in addition to an IRIS Focus

license.

IRIS Focus Seat-based License

IRIS Focus licenses are available in different configurations. To increase your seat count, you
must replace the current license with a new one by contacting your Vaisala representative.

The seat count defines how many users can access IRIS Focus at the same time. When a user
logs in, they occupy a seat. When a user logs out, the seat is released and the next user can
take it. If a user logs in when all the licenses are reserved, the user is shown IRIS Focus Light
until an IRIS Focus license is released.
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Nowcasting is only available to users with an IRIS Focus seat.

Seat counts within a workstation are browser-based. For one license reservation, users may
view IRIS Focus in as many instances or tabs of one browser, such as Firefox®, as they like. If a

. . ™
user opens IRIS Focus in a different browser, such as Google Chrome , they reserve one
license for each browser.

More Information

» User Management (page 64)
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3. Requirements

3.1 IRIS Focus Hardware Requirements

Minimum Hardware Requirements

* Modern 4-core CPU (Intel Xeon ES5 series or similar)
* 16GB RAM

* 1TBHDD

* 1280 x 800 minimum screen resolution

Recommended Hardware Requirements

* Modern 8-core CPU (Intel Xeon E5 series or similar)
* 32GB RAM

* 2x1SAS TB HDD in RAID 1 configuration

* 1920 x 1200 screen resolution

The pre-installed IRIS Focus system delivery option uses the Dell PowerEdge R430 rack server
unit, which meets the recommended hardware setup. See the Dell product data sheet for full
specifications.

The hardware capacity directly affects the performance of IRIS Focus. Multiple users can be
logged in to IRIS Focus, and each user can have multiple weather and terrain layers rendered
on screen at the same time. Each weather and terrain layer requires some resources from the
system.

For optimal performance, Vaisala recommends running IRIS Focus on a dedicated hardware
server and not in a virtualized environment.

3.2 Software Requirements

Before installing IRIS Focus, your environment must meet the following software requirements.

IRIS Network

IRIS network, such as an IRIS Analysis instance must be configured correctly to make data
from at least one radar site available for IRIS Focus.

CentOS 7.x

CentOS 7.1 or later DVD/ISO image mounted on your server (offline installation) or a functional
internet connection (online installation).

The installation script verifies the version of several core system packages during the
installation and updates them from the mounted media or Internet.



Version 4.0 Administrator Guide M211850EN-E

IRIS Analysis

The IRIS Analysis server set up provides radar products through a proprietary socket server
connection. The socket server connection is enabled if at least one radar is connected to your
IRIS Analysis server, and the IRIS Analysis server has IRIS software version 8.13.6 or newer
installed. No further configuration is needed.

The map projection in the IRIS Focus web application depends on having a single radar or a
group of radar sites to act as a center point to for map rendering.

In most IRIS Focus configurations, the radar product generator is an IRIS Analysis server that
has been set up earlier on the radar site. For more information, please contact Vaisala.

For information on configuring IRIS Analysis, see /RIS and RDA Software Installation Guide.

Before beginning the IRIS Focus installation, make sure you know the hostname
of your socket server.

Data Manager

Radar volume data is fetched from the data manager interface and processed into live radar
products in the IRIS Focus application.

The data manager does not need to be active during installation.

Data source Processing Visualization
)
|R|S /_ Data manager |R|S FOCUS
ret | Analysi
IRIS ‘:;g:ts: na VSIS Live [fi7ippI,cAPPI Web Browser
> product |[_! —= -
Radar 1 } 1 processor L Controls ,r\r}‘:‘\ lh—!
Preconfig.é i Processed product pictures r= 3
product | &} -
processor | J\
\—/ Socket \

Figure 3 Generating Live IRIS Products

More Information

» Setting up Data Manager (page 30)
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3.3 IRIS Focus Network Requirements

Table 3 IRIS Focus Network Requirements

Item Specification

Communication from IRIS Analysis to IRIS Focus

Network data transfer

>100 Mbit/s (1000 Mbit/s
recommended)

Communication from IRIS Focus to IRIS Analysis

Single user (1 seat) Network Data Transfer > 450 kbit/s
Latency ~150 ms

Multiple simultaneous users 5 seats > 2.5 Mbit/s
10 seats > 5 Mbit/s
20 seats >10 Mbit/s
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4. Installation
Option A

Server Delivery

Server preinstallation
done at Vaisala

Configure Server

Option B
USB Stick Delivery

-
p

‘»\5’“

USB Stick contains:

Install CentOS 7

M211850EN-E

Option C

Download

ftp.sigmet.com/
outgoing/releases/
Focus

*IRIS Focus Download Packages
* Map & Terrain data * IRIS Focus
* CentOS 7 * Map and Terrain data
* CentOS 7
Before You Start Before You Start

* Install CentOS 7

Run Install Script

Activate License

Figure 4 IRIS Focus Delivery Options

Option A Pre-installed system delivery from Vaisala. The "turnkey" option. Place an order
and wait for delivery by Vaisala.
Option B Preconfigured USB stick containing the CentOS operating system and all required
files for installing IRIS Focus.
Option C  Downloadable installation packages. Download the required packages to install
IRIS Focus on your server.

4.1 Downloading Installation Packages

p 1. Connect to Vaisala Sigmet server (ftp://ftp.sigmet.com) using an FTP client.
The host server allows read access for anonymous FTP connections.
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2. Navigate to /outgoing/releases/IRIS/Focus/<latest version>

3. Download the following files:

The files are very large. Use a download tool such as CrossFTP that allows
resuming downloads to fetch the packages.

a. IRIS Focus web application package: Vaisala_IRIS_installer-<latest
version>. tar

b. Maps directory: vaisala-iris-maps-v2.zip
c. Terrain data directory: vaisala-iris-terrain-v2.zip

4. If you require the Centos installation image, download it from:
ftp://ftp.sigmet.com/outgoing/releases/Cent0S/7.3/Cent0S-7-x86_64-Everything-1611.iso

You can skip the CentOS installation image if you already have an
appropriately configured CentOS installed.

4.1.1 Verifying MD5 hashes
Each file has an associated md5sum file located in the same download directory.

After downloading the file(s), verify their integrity by checking each file's MD5 hash against
the one provided at the installation site.

p 1. Do one of the following:
* In CentOS - Use the pre-installed md5sum command line tool:
md5sum [filename]
* In Microsoft Windows - Use the pre-installed CertUtil utility:
certutil -hashfile [filename] MD5

2. Check that the hashes match completely with the reference hashes at the download
source
If you see any discrepancies, the downloaded file is likely corrupted.

3. If you see any discrepencies in the hashes, download the mismatching file again.

4.2 Prerequisites for Installation

Before installing IRIS Focus, make sure your environment meets the necessary hardware and
software requirements.


http://www.crossftp.com/
ftp://ftp.sigmet.com/outgoing/releases/CentOS/7.3/CentOS-7-x86_64-Everything-1611.iso

>
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More Information

» IRIS Focus Hardware Requirements (page 11)
»  Software Requirements (page 11)

4.3 Installing CentOS

A prerequisite for installing IRIS Focus is that CentOS is installed on your intended IRIS Focus
system.

This version of IRIS Focus has been tested with CentOS 7.3. We expect IRIS Focus
to also work with later versions of CentOS 7.x.

If you do not have a CentOS system running, select an installation image from Vaisala Sigmet
server (ftp://ftp.sigmet.com/outgoing/releases/centos), and see instructions at Tecmint Linux
Guides (http://www.tecmint.com/centos-7-3-installation/) on how to perform a CentOS
installation.

Install CentOS according to the instructions, with the following changes.

1. Select your installation language.


ftp://ftp.sigmet.com/outgoing/releases/centos
http://www.tecmint.com/centos-7-1-installation
http://www.tecmint.com/centos-7-1-installation
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2. In DATE & TIME, set the system clock to Coordinated Universal Time (UTC) by choosing
the following values:
* Region: Etc
 City: Coordinated Universal Time

DATE & TIME

GMT-14

Region: E«i‘t\ City: o Network Time [__JIOFF] jﬂ
GMT-12 —
GMT-11
GMT-10
GMT-9
GMT-8
GMT-7
GMT-6
GMT-5
GMT-0
GMT-3
6MT-2
GMT-1
GMT+1
GMT+2

GMT+3

GMT+4
alla ol GMT+5
® 24-hour

13:40 PM AMIPM

‘v ||| v GMT+7

GMT+6 November v ‘ 5 v| 2015 v‘
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3. In SOFTWARE SELECTION, set the server type by selecting the following software
installation options:
* Base Environment type: Server with GUI
* Add-ons: Java Platform

SOFTWARE SELECTION

Dane

Base Environment Add-Ons for Selected Environment

Minimal Install
Basic functionality

Infrastructure Server

Server for operating network infrastructure services

File and Print Server
File, print, and storage server for enterprises

ic Web Server

Server for serving static and dynamic internet content.

Virtuslization Host

Minimal virtualization host

Server with GUI

Server for operating network infrastructure services, with a GUI.

GNOME Desktop
GNOME is a highly intuitive and user friendly desktop environment

KDE Plasma Workspaces
The KDE Plasma Workspaces, a highly-configurable graphical user
interface which includes a panel, desktop, system icons and desktop
widgets, and many powerful KDE applications.

and Creative
Workstation far software, hardware, graphics, or content
development

FaTawWare MONKCIING UTITIES
A set of tools to monitor server hardware,

High Availa bility

Infrastructure for highly available services and/or shared storage

Identity Management Server
Centralized management of users, servers and authentication policies.

Infiniband Support
Software designed for supporting clustering and grid connectivity
using RDMA-based InfiniBand and IWARP fabrics.

Java Platform

Java {\pport for the CentOS Linux Server and Desktop Platforms.

KDE
The KDE Plasma Workspaces, a highly-corfigurable graphical user
interface which includes a panel, desktop, system icons and desktop

widgets, and many powerful KDE applications.

Large Systems Performance

Performance support taols for large systems

Load Balancer

Load balancing support for network traffic.



4. In INSTALLATION DESTINATION, start manual partitioning:

a. Select the hard disk.

b. Select I will configure partitioning.

c. Select Done.

INSTALLATION DESTINATION

one

Device Selection

Chapter 4 - Installation

Select the device(s) you'd like te install to. They will be Left untouched until you click on the main menu's "Begin Installation” button,

Local Standard Disks

ATA VBOX HARDDISK
sda / 1.227TB free

Specialized & Network Disks

Add a disk...

Other Storage Options
Partitioning

Automatically configure partitioning 0* I will configure partitioning

Encryption
Encrypt my data. set a passphrase later

Full disk summary and beetloader...

Disks left unselected here will not be touched.

Disks left unselected here will not be touched.

1 disk selected; 1.22 TB capacity; 1.22 TB free
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5. Select Click here to create them automatically.

MANUAL PARTITIONING

one

~ New CentQS 7 Installation
You haven't created any mount points for your
CentOS 7 installation yet. You can:
Click here to create them ggtomatically
* Create new mount points by clicking the '+
button

News mount points will use the following
partitioning scheme:

LVM v
When you create mount points for your CentOS 7 installation, you'll be able to view their details here.
+ c
AVAILABLE SPACE TOTAL SPACE
122TB 122TB
1 storage device selected Reset AlL

6. Select /home.

a. Under Desired Capacity, increase the size of the home partition (/home) by typing
50 GiB.

b. Select Update Settings.

20
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7. Create the /var partition:

a. Select the plus (+) icon.
The ADD A NEW MOUNT POINT dialog appears.

ADD A NEW MOUNT POINT

More customization options are available
after creating the mount point below.

Mount Point: fvar e

Desired Capacity:

Cancel Add mount point

b. In Mount Point, type /var
c. Under Desired Capacity, set the size of the /var partition by typing 30 G1iB.
d. Select Add mount point.

8. Select /boot.

a. Under Desired Capacity, increase the size of the /boot partition (/) by typing
500 MiB.

b. Select Update Settings.
9. Select /.

a. Under Desired Capacity, increase the size of the root partition (/) by typing
100 G1iB.

b. Select Update Settings.

10. Select swap.
a. Under Desired Capacity, increase the size of the swap partition by typing 32 G1iB.
b. Select Update Settings.
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11. Create the /srv partition:

a. Select the plus (+) icon.
The ADD A NEW MOUNT POINT dialog appears.

ADD A NEW MOUNT POINT

More customization options are available

after creating the mount point below.

Mount Point: fsrv b

Desired Capacity:

Cancel Add mount point

b. In Mount Point, type /srv

c. Under Desired Capacity, use the remainder of the server space for the /srv partition
by typing 9999999.
The user interface fills in the available server space.

d. Select Add mount point.

e. Select any other dialog box.
The partition size changes to cover the available space.

12. Select Done.
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13. Check that the partitions are defined as follows:

MANUAL PARTITIONING
_

D

~ New CentOS 7 Installation

fhome
centos-home

tvar
centosvar

fboot
sdal

!

centos-reot

swap

centos-swap

3

o

avaiLagLe space [ll TOTAL spa
9925 KiB @117.25GiB

1 storage device selected

14. Select Done > Accept Changes.

50 GiB

30 GiB

500 MiB

100 GiB

32 GiB

15. Select Begin Installation.

centos-srv

Mount Point:
Jsrv

Desired Capacity:
90476 GiB

Device Type:
LVM v Encrypt
File System:

xfs v

Label:

4.3.1 Setting the Root Password

The default password is XX XXXXXX.

1. Select ROOT PASSWORD.
The Root Password window opens.

2. Enter your root password.
Check the password strength meter. While Vaisala recommends a strong password, the
software does not stop you from entering a weak one.

3. In the confirm text box, re-enter your root password.

Chapter 4 - Installation

Device(s):

ATA VBOX HARDDISK (sda)

Volume Group

centos

Modify.

Name:

Note: The settings you make an this screen will
not be applied until you click on the main menu's
‘Begin Installation’ button.

Reset All

4. In the upper left hand corner, select Done to return to the main configuration page.
If your password is weak, you are prompted to select Done a second time.

In the Installation Summary/Initial Settings page, the text under Root Password says Root

password s set.
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4.3.2 Creating CentOS User Accounts and Finalizing the
Installation

After you have started the CentOS installation, you are prompted to create a non-root user
account.

p 1. Select USER CREATION.

2. Create an account with the following properties:
* User name: radarop
» Password: [chosen password]

CREATE USER

Fullname  Radar Operator

Username  radarop
Tip: Keep your username shorter than 32 characters and do not use spaces.

Make this user administrator
@ Require a password to use this account

Password ®esessssssssssssess

Strong

Confirm password | tessssssnsnnsssnnnsy

Advanced

Figure 5 Creating User Accounts

3. In the upper left hand corner, select Done to return to the main configuration page.
If your password is weak, you are prompted to select Done a second time.
The installation continues for a few minutes.

4. When prompted, select Reboot.

5. Select LICENSE INFORMATION.
Accept the license agreement.

6. Select Done.
7. Select FINISH CONFIGURATION.

The CentOS installation is now complete. You are ready to install IRIS Focus.

4.3.3 Configuring the Network for CentOS

p 1. Inthe CentOS installation screen, select NETWORK & HOSTNAME.

2. Configure the network according to your organization's requirements.
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4.4 Upgrading Existing CentOS 7 Setups

If you have an existing CentOS 7 system running, you do not have to install a new system from
scratch. Updating the necessary packages to support IRIS Focus is enough.

Take a backup of the system before upgrading so that you can restore it in case anything goes
wrong.

More Information

» Backing-up System Configuration (page 73)

4.4.1 Online CentOS 7 Upgrade

If the server is online, upgrade it to the required CentOS 7.x level.

p 1. Login as root
2. Enter the following commands:
a. To clean the yum package manager cache directory: yum clean all
b. To list the lists packages that will be updated: yum check-update

c. To download and install the packages: yum update
This takes some time depending on the amount of packages and network speed.

3. Reboot the system.

4.4.2 Offline CentOS 7 Upgrade
Use a USB stick with CentOS 7.x on it or a mounted CentOS 7.1 ISO to upgrade a system offline.

p 1. Loginas root.

2. Modify the file /etc/yum. repos.d/Cent0S-Base. repo and comment out all lines
under the [base] repository by entering a # mark at the beginning of each line.

3. Add the following lines under the [base] repository:

[base]

name=Cent0S- Base-Offline
baseurl=file:///mnt/centos71/
enabled=1

gpgcheck=0

file:///mnt/centos71/ is the mount point of the CentOS 7.11SO image.
If you use an auto-mounted USB stick, use the 1sb1lk command to find the
mount point.

0 Make sure file:// isin front of the mount point in this file. The path
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4. Enter the following commands:
a. To clean the yum package manager cache directory: yum clean all
b. To list the lists packages that will be updated: yum check-update

c. To download and install the packages: yum update
This takes some time depending on the amount of packages and network speed.

5. Reboot the system.

4.5 Installing IRIS Focus Components

The script automatically installs all necessary services, user accounts, and modules required to
run IRIS Focus. The services start automatically.

Table 4 IRIS Focus Services

Service Description

monit Monitoring tool for Unix
systems and processes.

HAProxy Encodes outgoing traffic with
HTTPS encryption.
vaisala-radarsw-webapp IRIS Focus web application.
vaisala-radarsw-geoserver Map engine for caching and
generating base map layers.
vaisala-radarsw-nowcast-server Nowcasting server.
vaisala-radarsw-data-manager-service Data manager application.
vaisala-radarsw-data-manager—input-service Listener for incoming IRIS RAW
files.
vaisala-radarsw-warn-reader Listener for incoming WARN

products from IRIS Analysis.

Table 5 IRIS Focus Users

User ‘ Description

radardm Restricted user account for running the data manager
application.

radardminput Restricted user account for running the data manager input
service.

radargeo Restricted user account for running the GeoServer map engine.

radarweb Restricted user account for running the IRIS Focus web
application.
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Description

warnreader Restricted user account for running the warn service.

1. Make sure you have a CentOS 7 server system set up, and that you have received the IRIS
Focus installation files either as a USB delivery or as a download.

2. Make sure you have the IRIS Focus application installer, map data package, and terrain
data package available.
These are required because all IRIS Focus components are installed at the same time.

3. Mount the CentOS 7 USB stick or DVD.
Although CentOS 7 is already set up, the IRIS Focus installer relies on some packages that
are provided by the CentOS repository.

4. Loginas root.

5. Unpack the contents of the IRIS Focus installation file on the server, for example to the /
root/IRIS directory.
These files occupy approximately 40 Gb of space unpacked.

6. Navigate to the directory where you downloaded the files.

7. Launch the . /rsw-installer script.
The install script requires the following parameters:

./rsw-installer --offline --gis-db-dump [maps directory] --terrain-dir
[terrain directory] -s [socket server hostname]

* ——gis-db-dump - location for the map data

* ——terrain-dir - location for the terrain data

* —s - hostname of the socket server that provides radar product data from IRIS
Analysis

the ——onl1ine flag.

g If the computer is connected to the internet, you can run the installer with
This fetches any additionally required CentOS 7 packages from the internet

application database is first populated with map data.
Do not abort the installation if you do not see progress in a single step for up to 1
hour.

o The install process can take a significant amount of time, especially as the

More Information

» Security Settings (page 89)
» Uninstalling IRIS Focus (page 81)
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4.6 Running OS Hardening Scripts

When the IRIS Focus installation is complete, run the OS hardening scripts.

Table 6 Hardened Areas

Hardened Area

Install AIDE (Advanced Intrusion Detection Environment)

Restrict core dumps

Set permissions for grub configuration

Set default Message of the Day

Configure Chrony NTP

Configure TCP Wrappers

Strengthen log file permissions

Strengthen Cron configuration

Lockout for failed attempts

Password suffiency

Strengthen file permissions

Enable SSH issue banner

Disable IPv6

Remove support for unneeded file system types:

cramfs, freevxfs, jffs2, hfs, hfsplus, squashfs, udf, vfat, dccp,sctp, rds, tipc,
cups, avahi-daemon

p 1. Typethe command: /release/rsw-harden-os
The command executes the bash scriptsinthe /release/security-scripts
directory.
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4.7 Configuring IRIS for IRIS Focus

4.7.1 Setting or Changing the Socket Server

p 1. If needed, use the following commands to set or change the socket server:

/usr/vaisala/radarsw/configuration/bin/configure-iris-host
<socket_server_host_name>

rsw-basemap-site-setup --socket-server <socket_server_host_name>
service vaisala-radarsw-webapp restart

4.7.2 Activating the Socket Server in IRIS Radar

- Location_Radar Radar Status: DEFAULT x
File Menus Commands Mode Help
CONTROL SECTION

TASK Sched |: [DEFAULT Product Sched JW Output Sched _"W
Ingest Process [~ ’W Product Gen D,Idlei Product Qutput LI
Radiate JW Re-Ingest D,Idlei Network Recvr DW
T/R Power D’Or\i Messages Jlﬂi IRIS Webview D,Idlei
servo Power D’oni site Status J’m{i
Mode Switch ﬂ Inputs LI
SUBSYSTEM STATUS ANTENNA/TRANSMITTER STATUS
DSP oK Running Azimuth | 7455 velocity | 37.4
RCP OK N/A Computer Elevation W Velocity ’1087
WINDOW1 0K Idle oLW-1 K BITE J’Ol(i Waveguide W
Inputl N/A Idle Input
Transmit ’W Interlock W
Magnetron W Air Flow W

Figure 6 IRIS Radar Status Menu

If your system is running IRIS Focus server, you must enable the IRIS Webview option in IRIS
Radar. For more information, see /RIS Radar User Guide.
p 1. Make sure IRIS has started.
2. In IRIS Radar, select Menus > Radar Status.

3. Enable Select IRIS Webview.
When enabled, the field shows the status of the server process, as Idle, Running, or
Stopped.

29



Version 4.0 Administrator Guide M211850EN-E

4.7.3 Setting up Data Manager

The data manager service runs on the IRIS Focus server that receives radar scan volume data,
stored in RAW file format, from the IRIS Analysis server and generates live radar products from
the data in real-time.

During installation, IRIS Focus sets up all necessary services, databases, and user accounts for
processing data. IRIS Focus features such as live products and dynamic composites require
RAW files.

Socket Server

| 4———— Custom protocol on top of TCPIP

p raw data files

Radar

RIS Focus IRIS Analysis

Figure 7 Radar Data Delivery Paths

4.7.3.1 Setting up Data Manager On IRIS Analysis server

You must configure IRIS Analysis to send the RAW files to the correct location before IRIS
Focus can use them by setting the target location on IRIS Focus server as a network Output
Device in IRIS Analysis.

The target location on IRIS Focus server is /srv/vaisala/radarsw/product_raw
directory, owned by the radarscan user.
1. Log in to the IRIS Analysis server as root.

2. In the terminal window, type: setup&
The IRIS Setup utility opens

3. Select Output.
4. Create a new output device:
a. In Number of output devices, increase the number of output devices by 1.

b. Press ENTER.
A new configurable output device is added to the end of the Output Device list.
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5. In the configuration pane for the new output device, configure the new output device
with the following settings:

. Device type: Network

o o

. Filename format: Native
. Target directory: /srv/vaisala/radarsw/datamanager/input
. User name: radarscan

. Host name: [IRIS Focus server]

-~ ® QO o

. Select File > Save.
g. Select File > Exit.
6. Restart IRIS:

service iris start
service iris stop
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7. In the terminal window, type: iris &
The IRIS menu options.

a. Select Menus > Product Output > Device.

M211850EN-E

b. Select the device you configured in the Setup utility.
c. In the drop down box on the far right of the window, select Headers Only.
File Menus Device Commands Help
Site Type Product Name Task From To Day Mon Year Files
0 1 [# I 2 i 2 oo
Apply | Grab | Alwild | wild Time | c
\ 100%/36943 Files 0.0K*/99990.0M Bytes &vl Default — | Headers Only —'|
g’i*l Opts
Site Type Name Product-Specific-Parameters Task Time Date Req&est
m
d. In the product list, select any RAW product.
e. Right-click the far right of the product name and select a radar site.
If needed, deselect any radar sites you do not want to include in the device
configuration.
- hel-fireball Product Output NETWORK2 hel-fire-fly : DEFAULT x
File Menus Device Commands Help
Site Type Product Name Task From To Day Mon Year Files
JF 3 L F
Apply | Grab | Al wild_| wild Time | Commands
| 100736918 Files 0.0K*/99985.4M Bytes @I Default — _te[wre jﬂ
2 WST
& ops| HFF
Site Type  Name Product-Specific-Parameters Task Time Date cp1
SHEAR SLINE-250 cp2 1%
WARN DEFAULT cPa
WARN DP-WARN-R
WARN SLINE-250 XPT o+
CATCH CATCH-R-400 X8T *
CATCH DP-CATCH X9T *
APHID GPM M XOT X2T X4T X180 *
RAW GPM2_RAW KER X6T X7T X8T X9T X108 KUM XOT X2T X3T X4T X5T|kuym =* |
RAW GVVOL A KER X6T X7T X8T X9T X10 KUM XOT X2T X3T X4T X5T -
RAW GVVOL_A RAW KER X6T X7T X8T X9T X180 KUM XOT X2T X3T X4T X5T Exit J
RAW  GVVOL B KER X6T X7T X8T XOT X10 KUM XOT X2T X3T X4T XST X11 KWA
RAW GVVOL_B_RAW KER X6T X7T X8T X9T X100 KUM XOT X2T X3T X4T X5T X11 KWA 7l
f. Select Apply.
g. Select File > Save As.
Define a name for the new Product Output or use the DEFAULT option.
h. Select OK.
i. Select Close.

8. Loginto the IRIS Focus server as root.
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9. Read the contents from the root account's public SSH key:

cat /root/.ssh/id_rsa.pub

10. Store the printed key string on a file or on the computer clipboard for later use.

11. Launch a one-time SSH connection to the IRIS Focus server.

ssh [IRIS Focus server IP address]

This saves IRIS Focus server's hostname in the IRIS Analysis server's known_hosts file.

4.7.3.2 Setting up Data Manager On IRIS Focus server

Because the RAW files on the IRIS Analysis server are handled by the local root user and RAW
files on the IRIS Focus server by the local radardminput user, you must add the IRIS
Analysis root account’s public SSH key to the IRIS Focus radardminput accepted keys list.

p 1 Loginto the IRIS Focus server as root.

2. If it does not exist already, create the following . ssh file:

# mkdir /var/lib/radarscan/.ssh
# chown radardminput:radarsw /var/lib/radardminput/.ssh
# chmod 644 /var/lib/radardminput/.ssh/authorized_keys

3. Edit the radardminput user's authorized SSH keys store with the command:

nano /var/lib/radardminput/.ssh/authorized_keys

4. After the last entry, append contents you copied from the IRIS Analysis server root
account's public key to authorized_keys.
This enables file transfer from the IRIS Analysis root account to IRIS Focus
radardminput user.

5. Check that the RAW files appear in the /srv/vaisala/radarsw/datamanager/
input directory on the IRIS Focus server.
A data manager updater service records metadata of the files in an PostgreSQL database,
which is accessed by the IRIS Focus web Ul when it generates live radar products from the
data.
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4.8 Verifying IRIS Focus Installation

b 1.

Restart the server.
IRIS Focus web application is set to launch automatically when the server starts.
Check that the web user interface is running at the default HTTPS port, and the following
default user accounts have been created in IRIS Focus during installation:
» Username: admin / password: admin123
» Username: user / password: user123

. Access the IRIS Focus web Ul by opening a browser on the IRIS Focus server and

navigating to https://localhost.
You should see the login screen for IRIS Focus web application.

. Log in with the default IRIS Focus user account.

Make sure the application loads, and the map view is displayed.

. Verify that Tracking Tool and Cross Section buttons are visible in the application Ul.

This verifies that IRIS Focus features are enabled.

. Enable the grid lines by selecting Map Features Lat/lon grid.

Depending on where the map view is centered, you should see slightly distorted grid lines
that are leading away from the equator. This verifies that the map projection is correct.

. Confirm that data manager is running:

a. Select Weather Products > Add Product.
b. Add a new Live PPI or Live CAPPI product.

c. Make sure you see weather data from the selected time on the screen.

4.9 Activating License - Online

b 1
2.

34
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3. Go to Vaisala License Manager Web at https://licensing.vaisala.com and select Product
Code in the Login Using field.

VAISAI.A / License Manager Web

Customer Login

Login Using: [product Key i

Product Key: ach4c0a3-626b-44¢3-a39d-b4f39a0edcs¢

4. Enter your product code and select Login.
5. Enter the locking code in the Request Code field.

Change Language *

Generate License
EID: Ole4fg****

~ Enter Quantity
Product Remaining Quantity ‘Quantity
IR15 2.0 1 1

Request code:

Remarks:

Generate Close
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6. Select Generate.
A popup window with the license string opens.

License Certificate

Contact: Customer: Vaisala Oyj - 327799

List of Activations

Product Key Name AID Quantity  Remaining Quantity
3186b594-9499-4c3a-859a- IR15 2.0 3667027 -dfc3-454d-afcb-3c6chb668f90d 1 0
43ceebbabat2

License String

kgz iLwdmimOAL F2fnAeoRgS0aDLA piOL
# “IRIS_Focus® version ™, expires Midnight

Save to File Append To File Back to List

7. Select Save to File to save the license string to a file on disk.
The file is saved by default with the name lservrc.

8. Install the license with the rsw-install-1license <location-of-the-license-
file> command.

9. Restart IRIS Focus services with the following command:

service vaisala-radarsw-webapp restart

10. Log in to IRIS Focus using an administrator account.
11. Select Admin > System > Licensing Management to view information about the license
(seats, end date, and start date).
More Information

» Licensing (page 9)

410 Activating License - Offline

If the server running IRIS Focus is not connected to internet, you must activate the license by
entering the IRIS Focus server locking code in Vaisala License Manager Web using an another
online computer and then transfer the license file to the IRIS Focus server.

P 1. Runrsw-show-machine-code > [filename] command on the IRIS Focus server

to get the product code specific to the server hardware.
This stores the product code string in a file.
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2. Copy the file to a removable media and transfer it to the online computer.

3. Go to Vaisala License Manager Web at https://licensing.vaisala.com and select Product
Code in the Login Using field.

VAISAI.A / License Manager Web

Customer Login

Login Using: [ product Key v

Product Key: ach4c0a3-626b-44¢3-a39d-b4f39a0edcs¢

4. Enter your product code and select Login.
5. Enter the locking code in the Request Code field.

Change Language ¥
Generate License

EID: Oledfg****

¥ Enter Quantity
Product Remaining Quantity Quantity

IR15 2.0 1

* Request code:

Remarks:

Generate Close
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6. Select Generate.
A popup window with the license string opens.

License Certificate

Contact: Customer:  Vaisala Oyf - 327799

List of Activations

Product Key Name AID

3186b594-9499-4¢33-859a- IR15 2.0 3e667d27-dfc3-454d-afch-3c6cb668f90d

43ceebbabac2

License String

NdEROBWTUNLOBhEHAFHDgmIBnkgz rLwdmimOALF2fnAeoRgS0alLA pilL
#Q722H355d3ZrJp wGseRnEz80Gyo# “IRIS_Focus” version =, expires Midnight
54d-afcb-3c6cb668100d

‘E

WLYnnGhM4bu27
OkSTRTB0uP3EA! ki of
of Jan 1, 2011, exclusive##AID=3e667d27-dkc

Save to File Append To File Back to List

M211850EN-E

Quantity  Remaining Quantity

o

7. Select Save to File to save the license string to a file on disk.
The file is saved by default with the name lservrc.
8. Copy the license file to a removable media, such as a USB stick, and transport the file to
the IRIS Focus server.
9. Install the license with the rsw-install-license <location-of-the-license-
file> command.
10. Restart IRIS Focus services with the following command:

service vaisala-radarsw-webapp restart

More Information

3

Licensing (page 9)
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5. Configuration

51 Adding/Removing Radars

When new radar sites are added or removed as data sources on the IRIS Analysis server, radar
settings on the IRIS Focus server must be re-syncronized. Settings requiring updates include
updating the radar site location in GeoServer and calculating new map projections.

p 1. Runradar site setup script: rsw-basemap-site-setup --socket-server
[socket_server_host_name]

2. Restart the IRIS Focus web application service: service vaisala-radarsw-webapp
restart

5.2 Configuring Composites

IRIS Focus administrators can set up and manage pre-defined composites.

Configuring pre-defined composites provides more control over settings such as the
combining algorithm and Max Time Span.

IRIS Analysis Composites are set up in IRIS Analysis as IRIS COMP products and sent to IRIS
Focus much like other pre-configured products.

VAISALA / RS Focus

[EENCS S SECl  Product Configuration

Motion Vector Field Settings  Composite Settings

Composite Settings @rep
Name Composite Method Max Time Span Radar Sites
Tberia 2 Maximum 15 min Benidorm_ES
Lisbon_PT
Porto_PT
Add New Ssave
RIS Analysis Composites @rep
Name
Fiji

Figure 8 Composite Settings

5.2.1 Setting-up Pre-defined Composites

p 1. LogintoIRIS Focus as admin.
2. Select Product Configuration > Composite Settings.
3. Select Add New.
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4. Give the composite site a name.

5. Under Composite Method, select the algorithm applied to overlapping data.
See IRIS Focus Composite Methods (page 40).

6. Define the Max Time Span for the composite.
See Max Time Span (page 41).

7. Under Radar Sites, select the sites you want to include in the composite.

8. Select Save.

5.2.2 Editing Pre-defined Composites
p 1 LogintoIRIS Focus as admin.
. Select Product Configuration > Composite Settings.
. Select a composite on the list.
. Adjust the composite method or time interval as needed.

2

3

4

5. Under Radar Sites, select the sites you want to include in the composite.

6. To remove a site from the composite, select the X next to the site you want to remove.
7

. Select Save.

5.2.3 Deleting Pre-defined Composites

p 1 Loginto RIS Focus as admin.
2. Select Product Configuration > Composite Settings.
3. Select a composite on the list and then select Delete.

4, Select Save.

5.2.4 IRIS Focus Composite Methods

For regions where radars overlap, you can select one of the following methods for combining
radar data:

* Maximum
Maximum uses the maximum value to combine the data. This is the most common setting.
* Average
Average uses the average of the available data. This is a poor choice if you are trying to
cover blocked regions.

IRIS Analysis supports an expanded set of composite methods. For more
information, see /RIS Product and Display Guide.
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5.2.5 Max Time Span

Max Time Span is the maximum time (minutes) allowed between the newest and oldest points
of data. When new data is processed, points that are older than the specified time span are
removed.
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5 Minute Max Time Span

M211850EN-E

14:38-> 15:00
Radar task schedule ;
1
S ? | ()
|
1
S @ | .
|
I
|
® '
X @ '
1
1
15 Minute Max Time Span
14:38->15:00

x P

P
P

x ¢

x @

< - > |

ONONO

Figure 9 Max Time Span

1 Each radar has a different schedule with tasks 5, 7, and 10 minutes apart.
2 Max Time Span indicates which volumes are available for the composite calculations.

3 The composite calculation chooses which volumes to use.
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5.2.6 Viewing a List of IRIS Analysis Composites

IRIS Analysis Composites are set up in IRIS Analysis as IRIS COMP products and sent to IRIS
Focus much like other pre-configured products.

p 1. Loginto IRIS Focus as admin.
2. Select Product Configuration > Composite Settings.
3. Scroll down to the IRIS Analysis Composites pane.

5.3 Configuring Nowcasting

Nowcasting is enabled by default. However, during installation or later, you can adjust the
nowcasting configuration.

For information on using nowcasting, see /RIS Focus User Guide.
Configuring IRIS Focus for nowcasting includes:

* Enabling nowcasting in the IRIS Focus web application and the nowcasting server.
» Configuring MVF and nowcasting criteria.
* Fine-tune the algorithms.

Most users do not need to adjust the nowcasting algorithms.

More Information

»  Configuring MVF (page 43)
» nowcast.ini (page 93)

5.3.1 Configuring MVF

To use nowcasting, for each radar site you must enable motion vector field (MVF) generation
and pre-configure the MVF product to define a product type and product name.

IRIS Focus generates one MVF product per site. If meteorological conditions vary
across your radar sites, you may wish to use different products for each radar site.

For information on radar products and product codes, see /RIS Focus User Guide.
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VMSM.A / IRIS Focus
Map Preferences

Motion Vector Field Settings @ Help

Motion vector calculations are the first step in nowcasting calculations.

Site Reference Product MVF Generation
KER (Kerava, radar) | CAPPI - 1KM_REFL_ADV ¥ B on
PLA (Philippines_A) | PPI - SURVEILLANCE * Bl on
PLE (Philippines_B) Y |13 off
PLC (Philippines_C) ¥ | |I[I|Z3 off
X2T (X2_Argentina) X I, off
PHP (Philippines) PPI - SURVEILLANCE ¥ | ||||T3 off
Save

p 1. LogintoIRIS Focus as admin.
2. Select Product Configuration > Motion Vector Field Settings.

3. For each radar site, select whether MVF generation is enabled for that site.
To minimize performance problems, do not enable MVF generation for sites that do not
need the nowcasting feature.

4. For the sites with MVF generation enabled, select the product used to create MVF
products.
The product can be of any data type except V and PHIDP.

Minimize performance problems by avoiding:
0 * Products that generate too much data, for example, those with large
resolutions.
Vaisala recommends using a CAPPI at 2km height at with a 480x480
resolution.
» Generating the MVF product too frequently.
Vaisala recommends using products that are configured to be created
no less than 10 minutes apart.

For more information on pre-configuring products, see /RIS Radar User Guide and IRIS
Product and Display Guide.

44



Chapter 5 - Configuration

5. Select Save.

More Information

»  Configuring Nowcasting (page 43)
» File Locations (page 91)
» vsoweb-override.ini (page 95)

5.3.2 Enabling the Nowcast Server

You must have a nowcasting license to use nowcasting in IRIS Focus.
See Licensing (page 9).

After a default installation, the nowcast server is running by default.

When troubleshooting nowcasting, check that the nowcasting is enabled and that the nowcast

server is running.

If you change the configuration, you must restart the nowcast server.

1. Login as root.

2. Goto /etc/vaisala/radarsw/configuration/vsoweb-override. inti.

3. Inthe [NOWCAST] section of the vsoweb-override.ini file, check that the nowcast

server is enabled:

nowcast.mvf.run: true

4. Check the nowcast server URL:

nowcast.http.server.url = http://localhost:34480/api/vl/mvf/

If you have not changed vsoweb-override.ini, you do not need to

o restart the vaisala-radarsw-webapp server.

The nowcast server is running by default. If you have not changed

nowcast.ini, you do not need to restart the nowcast server.

5. Restart the vaisala-radarsw-webapp service by typing:

service vaisala-radarsw-webapp restart
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6. Start the nowcast server by typing:

service vaisala-radarsw-nowcast-server start

a. To verify that the server starts, type:

systemctl status vaisala-radarsw-nowcast-server.service

b. Check for the status:

Active: active (running)

5.3.3 Starting the Nowcast Server

p 1. Loginas root.

2. Start the nowcast server by typing:

service vaisala-radarsw-nowcast-server start

a. To verify that the server starts, type:

systemctl status vaisala-radarsw-nowcast-server.service

b. Check for the status:

Active: active (running)

5.3.4 Stopping the Nowcast Server

p 1. Loginasroot.
2. Stop the nowcast server by typing:

service vaisala-radarsw-nowcast-server stop

5.3.5 Restarting the Nowcast Server

p 1. Loginas root.
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2. Restart the nowcast server by typing:

service vaisala-radarsw-nowcast-server restart

5.4 Managing Alerts for Significant Weather
In IRIS Focus, a weather event is an occurance of a pre-configured WARN product appearing in
the display.

A weather event becomes an alert when the pre-configured WARN product moves into a
protected area in the display.

To use IRIS Focus alerts, you must define WARN products in IRIS Radar and then draw
protected areas in IRIS Focus.

Perform the steps in the following sections.
1. Learn about IRIS WARN products.
See WARN : Warning/Centroid Product (page 47).
. Setting-up Public Key Authentication for WARN Products (page 50).
. Configuring WARN Products (page 51).
. Scheduling WARN Products (page 54).
. Configuring an IRIS Output Device for WARN Products (page 56).
6. Sending WARN Products from IRIS to IRIS Focus (page 57).

2
3
4
5

When you have configured the WARN products that are displayed as events in IRIS Focus, draw
protected areas in IRIS Focus so you are alerted when an event enters that area.

5.4.1 WARN: Warning/Centroid Product
The WARN product uses other IRIS products to detect significant weather.

Example: Detecting Hail

The occurrence of 45 dBZ at 1.5 km above the freezing level is a good indicator of hail in
many mid-latitude locations. Assuming that the freezing level is at 4 km, and you run an echo
TOPS product for the 45 dBZ contour, your pre-configured warning could check if:

* The TOPS product shows 45 dBZ tops at heights greater than 5.5 km. If yes, there is a
high probability of hail.

* To avoid issuing an alarm based on a single pixel, a "threshold region” parameter checks
if the region of hail signature at least 10 km?Z.

* The VIL for the same region (1...10 km) is greater than 5 mm (or a value determined
from the local climatology of hail).
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shows how the WARN product works.
- considered (for example, >>5.5 km
4-.I
2 Smooth and connect the regions that
)
| 3 Contiguous regions are identified by a
region is computed.
Regions below the threshold size are
region is in a protected area.
within protected areas.
HAE| |:|

The WARN product automates this procedure in real time by searching the products for
Figure 10 HAIL Warning/Centroid
TOPS of 1 Threshold the input product (45 dBZ
45 dBZ TOPS in the example) so that only
(3.4 mi)).
are almost touching, and eliminate any
region finder procedure.
discarded.
5 Display the WARN product as an event
HAIL

significant weather, and alerts the operator when an event is detected. The following figure
| points greater than the threshold are
The result is a 2-D binary array.
isolated bins.
The centroid location and area of each
4 Determine whether any part of any
| outside protected areas or as an alert
HAIL in AREA_A

48



Chapter 5 - Configuration

Warning Message

You can define the content of the message. For example:

2 HAIL Warnings at 11:30:00 in: AREA_A AREA_B
In this case, HAIL is the user-selected warning text and AREA_A is the user-selected name of
the protected area.
The names and locations of protected areas are defined in the IRIS Setup utility.

The messages are added to the IRIS Message Summary menu.

Warning Criteria

The automatic warning feature can provide alerts for a wide variety of weather phenomena,
such as the approach of a severe storm, turbulence, lightning hazard, or flood potential.

Up to 3 criteria can be used. The thresholding and smoothing is performed separately for each,
then the results are ANDed together so that centroid definition is performed on the combined
field. For example, the additional criterion of the 1...10 km (0.6 ... 6.2 mi) VIL >>5 mm (0.2 in)
could be added to reduce a HAIL warning false alarm rate.

The following table shows some examples of warning criteria. Each criterion, surrounded by square
brackets above, is one task. The results of multiple tasks are ANDed together.

Table 7 Warning Criteria Examples

Criteria Example

Wind shear detection [Shear >10 m/s/km at 0.5° EL]

AND
[ ... at 0.7° EL]

over an area of 3 km?2 (1.2 mi2)

Storm turbulence

detection [Spectrum Width >6 m/s (>19 ft 8 in / s)]

AND
[Reflectivity >20 dBZ]

over an area of 10 km? (3.9 mi2)

Hail detection
[45 dBZ TOPS >1.5 km (>0.9 mi) above freezing level]

over an area of 10 km? (3.9 mi2)

Precipitation surveillance

detection [1.5 to 14 km (0.9 to 8.7 mi) VIL >1 mm (>03g, in)]

over an area of 10 km?2 (3.9 mi2)
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Criteria Example

Severe storm detection or

lightning hazard [1.5 to 15 km (0.9 to 9.3 mi) VIL >10 mm (>023, 1in)]

AND
[16 dBZ TOPS >8 km (>5.0 mi)]

over an area of 10 km? (3.9 mi2)

Flash flood warning . . .
[Hourly Rainfall or N-Hour Rainfall >5 mm (>0%3, in)]

over an area of 25 km2 (9.7 mi2)

and experience. Vaisala can work with you to develop such a climatology or to
better understand the capabilities and limitations of the WARN product.

Vaisala makes no warranty, either express or implied, that the WARN product can
detect all hazardous weather situations. In no event can Vaisala be held liable for
damages of any kind for failure of the WARN product to issue a warning, or for
false alarms that may be issued by the WARN product.

o To function effectively, a WARN product must be based on the local climatology

5.4.2 Setting-up Public Key Authentication for WARN Products

To support sending WARN products from IRIS to IRIS Focus, you must add the public key of
the root user of the IRIS machine to the authorized keys list on the IRIS Focus machine.

This allows the files to transfer over the network securely, automatically, and without
passwords.
p 1. Onthe IRIS machine, copy the contents of: /root/.ssh/<public_key_file>
(for example id_rsa.pub)
2. On the IRIS Focus machine, if it does not exist already, create the following . ssh file:

# mkdir -m 700 /var/lib/warnreader/.ssh
# chown warnreader:radarsw /var/lib/warnreader/.ssh

the warnreader user and the radarsw group and that the permissions is

o Make sure the authorized_keys file in the . ssh directory is owned by
644.

3. On the IRIS Focus machine, copy the key file to:
/var/lib/warnreader/.ssh/authorized_keys
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4. Check that the ownerships are as follows:

User or Group Required Setting

warnreader user user

Group radarsw

5. Check that the permisssions are as follows:

Directory or File Permission

.ssh 700

authorized_keys 644

5.4.3 Configuring WARN Products

File Menus Type Help

Warning Symbol I LTGH

Area in Sg Km |200

Type Product Name Time Threshold
J|VIL [viL_130 J| B> 30.00 Apply | Clear |
1 TOPS  45Z 150 00:00:00 > 5.00

VIL 130 00:00:00 > 30.00

PROTECTED AREAS FOR WARNING ALERT

TDWR Style |7 | Say/Beep Warning _| | Make Diagnostic _| |

If you wish to be alerted to events entering protected areas you draw in IRIS Focus, you must
configure a WARN product for each tracked event in IRIS Radar.

Use the WARN product configuration menu to specify the message, the area of the threshold
region, and up to 3 products to use as criterion for the warning.
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IRIS Focus does not include a WARN product of its own. You must configure
WARN products in IRIS.

p 1. Inthe main menu bar, select Menus > Product Configuration.

2. In the main menu bar, select Type > WARN.
The WARN Product Configuration menu opens.

3. In Warning Symbol, specify the text used in the warning messages.
For example, the text may be, HAIL or MBW, S++, Or TRW+.
If you define the Warning Symbol with a predefined IRIS Focus Warning Symbol, IRIS
Focus displays the weather with as an icon. If you use a different Warning Symbol, IRIS
Focus displays the weather with the UNKNOWN icon.

Table 8 IRIS Focus Warning Symbols

IRIS Warning Symbol Label IRIS Focus Event Icon IRIS Focus Alert Icon

DOWNBURST l &
™ T
HATL gt ﬂ,l}
¥ il
THUNDERSTORM e i
= S
==
WINDSHEAR
. O
Other Warning Symbol value

4. Enter the minimum size of a thresholded region in the Area in Sq Km field.
Areas that do not meet or exceed this size are discarded. Enter the desired value in square
km.
For example, for a 3 km by 3 km (1.9 x 1.9 mi) size area, enter 9.

52



Chapter 5 - Configuration

5. Select the button next to Product Type and Product Name, select up to 3 products to be
examined by the WARN product.

respective Product Configuration menus.

* Products must have the same resolution per the respective Product
Configuration menus.

* Products must be of a supported data type: dBT, dBZ, dBZc,
He1ight, Kdp, LDRH, LDRV, R, Rain, RhoH, RhoV, RhoHV, Shear,
SQI, Time, VIL, Width, and ZDR.

0 * Products must have the same maximum product range per the

Errors are reported at run time in the Radar Status menu.

a. Select the product type.
The Product Name information is filled in automatically. You can also edit the name.

b. Select the product name.

The list of product names shows products currently in your system. If the

o product you want does not show, run your system until it does show.
Alternatively, chose a different product of the desired type and override
the product name.

¢. For each product, use Time values to use products from different tasks or different
runs of the same task.
Use the plus and minus buttons to increase or decrease the hours, minutes, or
seconds or type a time value in the window.
This field applies only when there is more than one criterion. For example, if the
second criterion has a time of 00:10:00, when the first product becomes available, the
scheduling algorithm searches back in time as far as 10 minutes to find a version of
the second product.
You must know your task schedule. If you use products based on different tasks, you
must set the Time field to some nonzero number or the product does not run. In
general, if all of your product criteria are based on the same task, set all the times to
00:00:00 so that only data from the same run are used.

d. For each product, enter the warning threshold in Threshold.
The WARN product considers only those values that meet or exceed the threshold. The
units of measure depend on the selected product. For example
* TOPS thresholds are specified in km
* VIL thresholds are specified in mm.

Check the appropriate Product Configuration menu if you are uncertain
about the units of measure.
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For the VVP product, the threshold refers to the divergence in units of m/s per km
(1073 5. When the WARN product is run for the VVP, a warning is generated if the
divergence exceeds this value at any height in the VVP. Strong low-level divergence
over the radar could be an indicator of a microburst. To properly set for microburst
alerts, you must know the local characteristics of the phenomena.

6. Do not configure Protected Areas for Warning Alert. You do this later in the IRIS Focus
display.

7. In IRIS Radar, schedule the WARN product.
a. Select Menus > Product Scheduler.
b. In Add for, select the radar site for which you want to schedule the WARN product.

c. Inthe list, right-click the WARN product header.
A list of all available WARN product configurations appears.

d. Inthe list of WARN product configurations, select the WARN product you just
configured.
The new product appears in the list in a stopped state.

e. To schedule the WARN product indefinitely, right-click the Status column for that row
and select All.

For more information, see /RIS Radar User Guide.

5.4.4 Scheduling WARN Products

0 You must configure WARN products before you can schedule them.

If you wish to use alerts and protected areas in IRIS Focus, you must schedule a WARN product
in IRIS Radar.

1. Select Menu > Product Scheduler.
A list of available product types appears.

2. On first line of the menu, select the button next to Add For and select the code for your
local radar.
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3. In the list, right-click the WARN product header.
A window appears listing the available WARN product configurations.

hel-fireball Product Scheduler: DEFAULT

Chapter 5 - Configuration

File Menus Commands Help
XXX i All sites 220/220 Products KER i
) \ [ 2202 addfor| || siecrop |2
WPT e Product Data Task Next-Data-Time skip Rgst Status Runs
:E: " dBZ VoL_A 13:30 19 DEC 2016 00:00 ALl Wait 1158 S
WsT )
HFF Height VOL A 13:30 19 DEC 2016 ©00:00 All Wait 1158
G Height GVVOL * 13:03 20 DEC 2016 00:00 ALl Wait 586
e Height GVVOL A 13:03 20 DEC 2016 ©00:00 All Wait 586
CP3 WARN-PPL-Z 3 L
6T WARN DOUG Height GVVOL B 13:09 20 DEC 2016 ©00:00 All Wait 584
— Height APHID_GPM2 13:08 19 DEC 2016 00:00 ALl Wait 289
X Height voL A 13:30 19 DEC 2016 00:00 ALl Wait 1158
Exit Height GVVOL A 13:03 15 DEC 2016 ©00:00 All Wait (]
oo TOPS-Z-250 Height GVVOL A 13:03 15 DEC 2016 ©00:00 All Wait (]
KWA TOPS TOPS-Z-250 Height GWVOL_A 13:03 20 DEC 2016 00:00 ALl Wait 586
KER TOPs TOPS-Z-400 Height GWVOL A 13:03 15 DEC 2016 00:00 ALl Wait ]
TRACK --Products--
VAD --Products--
KER VAD DEFAULT Null WIND 13:03 15 DEC 2016 00:00 ALl Wait 2]
KER VAD VAD-PROH Null WIND 13:03 15 DEC 2016 00:00 ALl Wait ]
VIL --Products--
KER VIL VIL-ZVIL-250 VIL VoL A 13:30 19 DEC 2016 ©00:00 All Wait 1158
KER VIL VIL-2VIR-2568 VIR voL_A 13:30 19 DEC 2016 00:00 ALl Wait 1158
VP --Products--
KER VVP DEFAULT Null PPI_HV250 ALl Wait ]
HFF  VVP DEFAULT Null PPI_Hv250 ALl Wait 386
KER BASE BASE-Z-250 ALl Wait 1158
HFF  WARN DEFAULT BASE BASE-Z-250 8 ALl Wait (]
HFB  WARN DP-WARN-R CAPPI DP-CAPPI-R 13:30 19 DEC 2016 00:00 ALl Wait 193
KER WARN PPI_Z-WARN PPI PPI-Z-400 12:03 15 OCT 2015 ©00:00 ALl Wait ]
HFB  WARN PPI_Z-WARN PPI PPI-Z-400 12:03 15 OCT 2015 00:00 ALl Wait ]
KER WARN WARN-250 PRI PPI-Z-250 13:03 15 DEC 2016 ©00:00 All Wait (]
KER WARN WARN-PPI-Z PPI PPI-SUR-Z 13:38 19 DEC 2016 00:00 Stop Wait 2]
BLG WARN WARN-PPI-Z PPI PPI-SUR-Z 13:03 15 DEC 2016 00:00 Stop Wait 2]
DBN WARN WARN-PPI-Z PPI PPI-SUR-Z 13:03 15 DEC 2016 00:00 Stop Wait ] |~
KER WARN WARN_DOUG PRI PPI_DOUG 13:03 15 DEC 2016 ©00:00 All Wait e 7

4. Right click the WARN product header.
A window appears listing the available WARN product configurations.

a. Select the WARN configuration you created earlier.
The product appears on the list of scheduled products in a stopped state.

b. Schedule the WARN indefinitely by right-clicking the Status column for that row and

selecting All.
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5.4.5 Configuring an IRIS Output Device for WARN Products

In IRIS, you must configure the IRIS Focus server as an output device to which IRIS copies
WARN product files. The output device configuration would look something like the following,
except the Menu alias and Recipient host name fields would be filled in with a name for the
output device and with the network address of the FIRE server (don't forget to save and
restart IRIS after making changes to output device configurations):

p 1. Inthe IRIS terminal window, type: setup&
The IRIS Setup utility starts.
2. Inthe IRIS Setup utility, select Output.

3. In Number of Output Devices, raise the number of devices by 1.
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4. Scroll down to the first unconfigured output device and begin configuring the device for
IRIS Focus WARN products.

File Help
3

Output Device #5 Helpl

Device type  Network —i |

Menu alias IEFIRE-FLY

Min time between output ID sec

File format IRIS (Def) — |
Filename format  Default — |
Compression scheme None — |
Notification scheme None — |

Target directory I}’srwvaisala,‘radarswfproduct,'warn

Copy scheme SCP

User name Iﬁwamreader

Recipient host name |E1?2.24.114.45

Output Device #6 Helpl |
I

-

|-

a. For Device type, select Network.

b. For Menu alias type the name of the output device.
The image shows an example.

c. Recipient host name type the network address of the IRIS Focus Server.
The image shows an example.

5. Save your changes and restart IRIS to take the changes into effect.

5.4.6 Sending WARN Products from IRIS to IRIS Focus

When you have configured and scheduled the WARN product, you can start sending WARN
products over the network to IRIS Focus.

p 1. Inthe IRIS terminal window, type: i ris&
The IRIS Radar application starts.
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2. Select Menus > Product Output.
3. In the Device menu, select the IRIS Focus device you want to send products to.

This is the device you configured in Configuring an IRIS Output Device for
WARN Products (page 56).

4. Filter the list of output products:

Malatya Product Output NETWORK6 MARKO : DEFAULT

File Menus Device Commands Help
Site Type Product Name Task From To Day Mon Year Files
JIIXST JIWARN B [ J|* B Jl*—Jl*iJw meo
Apply | Grab | All wild | wild Time | Commands |
\ 56/16001 Files 363.0K/39994.0M Bytes g‘ Default — ALL | Filesonly
Site  Type  Name Product-Specific-Parameters Task Time Date ANK
WARN b &
X6T WARN SLI 0.65gkm 1:In 3:Areas GVVOL A 13:23:20 15 DEC 2016 E"E“R
X6T WARN SLI 0.0Sgkm 1:In 3:Areas GVVOL_A 13:11:20 15 DEC 2016 A-H
X6T WARN SLI 0.05gkm 1:In 3:Areas GVVOL A 12:59:20 15 DEC 2016 1
X6T WARN SLI 0.05gkm 1:In 3:Areas GVVOL A 12:47:21 15 DEC 2016
X6T WARN SLI 0.0S5gkm 1:In 3:Areas GVVOL A 12:35:20 15 DEC 2016
X6T WARN SLI 0.0S5gkm 1:In 3:Areas GVVOL A 12:23:20 15 DEC 2016
X6T WARN SLI 0.06Sgkm 1:In 3:Areas GVVOL A 12:11:20 15 DEC 2016
X6T WARN SLI 0.06Sgkm 1:In 3:Areas GVVOL A 11:59:20 15 DEC 2016
X6T WARN SLI 0.06Sgkm 1:In 3:Areas GVVOL A 11:47:20 15 DEC 2016
X6T WARN SLI 0.65gkm 1:In 3:Areas GVVOL A 11:35:20 15 DEC 2016
X6T WARN SLT 0.05gkm 1:In 3:Areas GVVOL_A 11:23:21 15 DEC 2016
X6T WARN SLI 0.05gkm 1:In 3:Areas GVVOL A 11:11:20 15 DEC 2016
X6T WARN 0.05gkm 1: 3:Areas $59:20
X6T WARN [} 1 13:Areas SURV_TRMM
X6T WARN THUNDERSTRM THU @.5Sqkm 1:In 13:Areas SURV_TRMM 13:22:20 15 DEC 2016
X6T WARN THUNDERSTRM THU 0.5Sqkm 1:In 13:Areas SURV_TRMM 13:10:19 15 DEC 2016
X6T WARN THUNDERSTRM THU 0.5Sqkm 1:In 13:Areas SURV_TRMM 12:58:20 15 DEC 2016
X6T WARN THUNDERSTRM THU 0.55qkm 1:In 13:Areas SURV_TRMM 12:46:20 15 DEC 2016
X6T WARN THUNDERSTRM THU 0.55qkm 1:In 13:Areas SURV_TRMM 12:34:21 15 DEC 2016
X6T WARN THUNDERSTRM THU ©.55gkm 1:In 13:Areas SURV_TRMM 12:22:20 15 DEC 2016

a. For the Site field, select the correct radar site.
b. For the Type field, select WARN.
c. Select Apply.
The WARN products that are generated for this radar site.are shown.

5. Right-clicking the Request column and select the site you want to start sending the
product to.
In the example above, the THUNDERSTRM WARN product will be sent to the X6T site.

5.5 Importing Historical Data to IRIS Focus

You can import historical data into IRIS Focus to use the same IRIS Focus visualization and
analytical tools available for current data.
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To import the data, use one of the following import methods:

» Transfer RAW product data from IRIS Analysis on the IRIS back-end to the IRIS Focus
machine. See IRIS Focus Architecture (page 82).

* Import a data archive by sending a collection of IRIS RAW products over the network using
an SCP command. See the following steps.

p 1. Setup public key authentication for the machine you are copying from:
Onthe _my.1iris.focus.server machine, add the key from the source machine to
the radardminput user's ~/.ssh/authorized_keys file.

2. Use SCP to copy all the files from /storage/raw/archive/ to the IRIS Focus Server.
For example:

find "/storage/raw/archive" -type f -exec scp {}
radardminput@my.iris.focus.server:/srv/vaisala/radarsw/datamanager/input;

The Data Manager input service expects only IRIS RAW files. Make sure you do
not copy a directory or zip file.

3. To monitor the data import, or troubleshoot if the data does not appear on the IRIS Focus
web interface, check the Data Manager input service log:

journalctl -u vaisala-radarsw-data-manager-input-service -f

The Data Manager input service imports the files to Data Manager for use in IRIS Focus.
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6. Upgrade

6.1 Upgrading IRIS Focus 3.0 to IRIS Focus 4.0

The following instructions assume you are upgrading from IRIS Focus 3.0 to IRIS Focus 4.0.

If you have previous versions of IRIS Focus, you must upgrade through each
previous version before you can upgrade to IRIS Focus 4.0.

IRIS Focus 4.0 requires a new license. If you do not yet have a license, please
contact your Vaisala sales representative.

1. Login as root.

2. Backup the system configuration.
See Making a Manual Back-up (page 73).

3. Download the following files:

The files are very large. Use a download tool such as CrossFTP that allows
resuming downloads to fetch the packages.

a. IRIS Focus web application package: Vaisala_IRIS_installer-<latest
version>. tar

b. Maps directory: vaisala-iris-maps-v2.zip
c. Terrain data directory: vaisala-iris-terrain-v2.zip
4. Insert the upgrade USB stick.

5. Copy thefile Vaisala_IRIS_installer-4.0. tar from the USB stick to the server's
hard disk drive, for example to the /root directory.

6. Extract the following files:

tar -xvf Vaisala_IRIS_installer-4.0.tar
unzip vaisala-iris-maps-v2.zip
unzip vaisala-iris-terrain-v2.zip

7. Change to the directory created in the previous step:

cd Vaisala-IRIS-Focus-v4.0.0--xx
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8. Run the upgrade script.
Online upgrade:

./rsw-upgrade --gis-db-dump [maps directory] --terrain-dir [terrain
directory] --online

Offline upgrade:

./rsw-upgrade --gis-db-dump [maps directory] --terrain-dir [terrain
directory] --offline

When running the-upgrade script, replace [maps directory] and [terrain
directory] with the correct paths.

g To view installation command line options, run: . /rsw—-upgrade -h

9. Verify the upgrade by running: rpm -qa | grep vaisala
Check that the rpm name is version 4.0.

10. Activate the IRIS Focus license.
Depending upon whether or not your server is connected to the internet, see:
» Activating License - Online (page 34)
» Activating License - Offline (page 36)

6.2 Upgrading IRIS Focus 2.1 to IRIS Focus 3.0

The following instructions assume you are upgrading from IRIS Focus 2.1 to IRIS Focus 3.0.

If you have IRIS Focus 2.0, you must upgrade to IRIS Focus 2.1 before you can
upgrade to IRIS Focus 3.0.

IRIS Focus 3.0 requires a new license. If you do not yet have a license, please
contact your Vaisala sales representative.

1. Loginas root.

2. Backup the system configuration.
See Making a Manual Back-up (page 73).

3. Insert the upgrade USB stick.

4. Copy thefile Vaisala_IRIS_installer-3.0.tar from the USB stick to the server's
hard disk drive, for example to the /root directory.
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5. Extract the file: tar -xvf Vaisala_IRIS_installer-3.0.tar

6. Change to the directory created in the previous step:
cd Vaisala-IRIS-Focus-v3.0.0--xx

7. Depending on whether you are performing an online or an offline ugrade, run one of the
following:Run: . /rsw-upgrade

./rsw-upgrade --online

./rsw-upgrade --offline

@ To view installation command line options, run: . /rsw—upgrade -h

8. Verify the upgrade by running: rpm -qa | grep vaisala
Check that the rpom name is version 3.0.

9. Activate the IRIS Focus license.
Depending upon whether or not your server is connected to the internet, see:
e Activating License - Online (page 34)
e Activating License - Offline (page 36)

6.3 Upgrading IRIS Focus 2.0 to IRIS Focus 2.1

The following instructions assume you are upgrading from IRIS Focus 2.0 to IRIS Focus 2.1

IRIS Focus 2.1.0 requires a new license. If you do not yet have a license, please
contact your Vaisala sales representative.

1. Loginas root.

2. Backup the system configuration.
See Making a Manual Back-up (page 73).

3. Insert the upgrade USB stick.

4. Copy thefile Vaisala_IRIS_installer-2.1.tar from the USB stick to the server's
hard disk drive, for example to the /root directory.

5. Extract the file: tar -xvf Vaisala_IRIS_installer-2.1.tar

6. Change to the directory created in the previous step:
cd Vaisala-IRIS-Focus-v2.1.0--55
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. Run: . /rsw-upgrade

g To view installation command line options, run: « /rsw-upgrade -h

. Verify the upgrade by running: rpm -qa | grep vaisala

Check that the rom name is version 2.1.

. Activate the IRIS Focus license.

Depending upon whether or not your server is connected to the internet, see:
» Activating License - Online (page 34)
» Activating License - Offline (page 36)
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7. System Administration

/71 User Management

Access to IRIS Focus features depends on the roles enabled for each user account.

For example, the administration features are available to user accounts with the administrator
role.

Table 9 IRIS Focus Roles

Role Description

administrator Can access administration features.

focus Can access the full IRIS Focus feature set.

kiosk Can only access the non-interactive, full-screen Kiosk mode.

user Can access the limited set of features available with IRIS Focus Light.
poweruser Not used.

To enable all IRIS Focus features for an account, set both user and focus roles for
that account.

Seat Allocation and Restrictions

Each logged-in user account with a focus role reserves one IRIS Focus seat from the license
pool. When the user logs out, the seat is released.

A user account that has user, administrator, or a role without focus role set enters IRIS Focus
Light, which has limited features and does not provide access to features such as cross-section
or live radar products.

If a user with a focus role logs in and there are no IRIS Focus seats available, the user enters
IRIS Focus Light. When a seat is available, the user is provided with an opportunity to switch to
IRIS Focus.

By default, an administrator account does not have the focus role set to avoid
reserving an IRIS Focus license when performing administration tasks.

Users and Organizations

Each user account belongs to one or more organizations. Each organization can have a
subscription to a selected software for a selected number of users.
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You can also use organizations to manage license availability to subgroups with separate
license pools.

More Information

» Licensing (page 9)

7.1.1 Managing User Accounts

p 1. Log in with an administrator account
2. Select Admin in the upper right corner.
3. Select Users to add, edit, or delete users.

7.1.2 Creating User Accounts After First Install

After a fresh installation, start creating user accounts.

To enable IRIS Focus features for a user account, you must select both the user
and focus roles.

p 1. Choose which organization you want to create your users in:
* Use the default root organization.

» For more control over license seat allocation, create a new organization in the
Organizations tab.

2. Subscribe the organization to a license pool in the Application Subscriptions tab:
a. Select the radarsw organization.
b. Enter the validity period.

c. Enter the maximum allocated users (licenses).

Application Subscription
Code IRIS Focus
Description Subscription to IRIS Focus|
]
Organization Example Inc. -
Application radarsw -

Start date 2015-10-21
End date 2016-10-21

Max number of users 5

Save Cancel
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3. Add users to the organization in the Users tab:
a. Add user details.
b. Select an organization for user.
¢. Add roles to user
d. Add both focus and user roles to make IRIS Focus features available.
e. To select multiple roles, press CTRL.

The default administrator account does not have the focus role set. This is to avoid
reserving an IRIS Focus license when performing administration tasks.

Users

(]

Add New User Search

4 Username State Email First name Last name Organizations and roles Timezone  Language  Actions
admin Active admin@vaisala.com

kiosk Active

poweruser Active

vision-user Active vision-user@email.com root (user)

7.1.3 Removing User Accounts

1. Login as admin.
2. Select Admin > User > Users.

3. Select a user and then Delete.
The user is no longer listed as a user in IRIS Focus. However, the user name of the deleted
account remains in the system database. This keeps log files intact, as references to
deleted users remain in the audit logs.
IRIS Focus does not allow you to create a new user with a similar user name as an existing
one. This applies even when the account has been removed beforehand, because the
account name remains in the database.

/.2 Map Management

The standard installation of IRIS Focus includes a complete world map that is suitable for most
scenarios.

The map consists of separate layers that are further separated into base layers and non-base
layers. One base layer and one non-base layer are always rendered on the screen. Typically,
base maps contain the underlying terrain and the non-base layers contain additional details
that can be displayed on top of the base map.

Map data is served to the IRIS Focus web interface by GeoServer map server using Web Map
Service (WMS) protocol. To improve performance, instead of calling for new map data each
time the map view changes, the maps are cached in pre-rendered PNG tiles using
GeoWebCache.

Administrators can add add custom map layers or edit existing layers.
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IRIS Focus users can view map layers in the Map view by selecting Map Features.

7.2.1 Working with Map Layers

1. Login as admin.

2. Select Admin > Map > Map Layers.

The Map Layers view lists the available map data layers. Each layer has the following
properties:

» Base layer - Enable to set this layer as a base layer

* Title - Layer name

* Type - WMS layers

* URL - Address for the WMS server

* Layer - Title of the layer on the server

3. To add a new layer, select Add New Layer.

a. Type the layer information, including Title, URL, and Layer.

b. Define map layer properties such as:
» Transparent - Enable to use PNG or GIF alpha channel for transparency
* MIME type - Select image type

4. To edit a layer, select Edit for that layer and make your changes

The Map Layer Information window for that layer opens.

5. Select Save.

More Information

» Map Layer Configuration Options (page 92)

7.2.2 Map View Context
The Map View Contexts view lists all defined maps.

Only the default TheMap context is available.

You perform all map layer customization in the default TheMap context, you do
not create new map contexts for custom map layers.

» To set which layers are enabled and which are disabled for users in the map view, edit
TheMap.

* To set the order in which multiple map layers are rendered on screen, change the Z level
of map layers.
The lowest number is rendered first, and higher numbers rendered on top of that.

67



Version 4.0 Administrator Guide M211850EN-E

Edit Map View Context ?

Map View Context Information =

Layers
Search

Selected A Title Layer group Second level layer group Visible Zlevel
7] aviation Base Map 7 5
Icdl baseLayer Base Map | 1]
" baseLayersimplified Base Map " 1
2] baselLayerTerrain Base Map | 2
& full Base Map 7| 7
1] -
Selected layer general
TR —

Cancel

Figure 11 Editing the Map Context

7.2.3 Adding External Map Layers

To perform these steps you must be familiar with Web Map Server (WMS) and
Geoserver

IRIS Focus displays single radar products in azimuthal equidistant projection.

0 Because most external Geoservers and WMS providers do not support azimuthal
equidistant projection, you must use a proxy to dynamically reproject the external
layer's projection to Azimuthal Equidistant projection.

Using IRIS Focus administrator tools, you can import an external map layer from Geoserver to
IRIS Focus for display in a composite radar view.

To add a layer to a radar AZEQ view, you must configure a Web Map Server (WMS) proxy to
the IRIS Focus Geoserver.
1. Open thefile: /etc/vaisala/radarsw/configuration/gis-override.ini

2. Copy the geoserver admin password.
This password is autogenerated during installation.

3. Login to IRIS Focus Geoserver at: http://<server>:34180/geoserver/web/
Login using the username admin and the password you copied earlier.


http://%3Cserver%3E:34180/geoserver/web/
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4. Add the new external WMS store. See the Geoserver documentation: http://
docs.geoserver.org/latest/en/user/data/cascaded/wms.html.
The following features are NOT supported:
+ Styling layers with Styled Layer Descriptor (SLD).
» Alternate (local) styles.
+ Extra request parameters such as time, elevation, or cql_filter.
* GetLegendGraphic requests.
+ Specifying the image format. GeoServer attempts to request PNG images. If that fails,
it uses the remote server’s default image format.
+ Authentication for the remote WMS. The remote WMS must be unsecured.

5. Publish the layers you want to display in IRIS Focus.
6. Login to IRIS Focus as admin user:
a. Select Admin > Map > Map Layers.
b. Select Add New Layer.
c. Add the layer with the information you entered in the previous step.

d. Add the new layer to the map view context TheMap.
Choose an appropriate Z level, most likely an integer one higher than the others is
good. This means that the layer will be displayed on top all the other layers.

7. In Geoserver, enable tile caching for the new layer.
a. Edit the new layer.
b. Navigate to Tile Caching.

c. Add a grid subset to all codes starting with EPSG: 741xxX.
This requires quite a bit of manual clicking.

and observe from browser network status which WMS requests fail. From
these requests, you can see the EPSG codes that your radar(s) use. You can
only use the EPSG codes currently used by the system.

g Instead of adding all the EPSG codes, you can go straight to the next step

8. Login to IRIS Focus as a user:
a. In the upper right corner, select Map Features.

b. Enable the new layer.

7.3 systemd

systemd and its logging daemon journald are CentOS 7 components that manage system
services.

systemd manages more functionality than its predecessors, and some of the mechanisms,
such as accessing certain log files, have changed.

69


http://docs.geoserver.org/latest/en/user/data/cascaded/wms.html
http://docs.geoserver.org/latest/en/user/data/cascaded/wms.html

Version 4.0 Administrator Guide M211850EN-E

In CentOS 7, system logs are not directly accessible as files. Instead, they are read with the
journalctl command.

7.4 Monit

Monit is a watchdog tool for monitoring Unix systems and processes. IRIS Focus uses Monit to
automatically restart the application or a related process or service if it becomes unstable.

If you do maintenance work that requires you to take the application down, you must first stop
Monit before proceeding further, and restart it after maintenance.

In the command line, the Monit service is called monii t.

7.5 HAProxy

HAProxy is a proxying tool that IRIS Focus uses for traffic forwarding within the system and
HTTPS encryption for outgoing traffic.

In the command line, the HAProxy service is called haproxy.

More Information

» Encryption (page 89)

7.6 IRIS Focus Web Application

This is the main web Ul of the IRIS Focus system.

In the command line, the IRIS Focus web application service is called vaisala-radarsw-
webapp

7.7 GeoServer

GeoServer is used for caching and generating the base map layers.

In the command line, the GeoServer service is called vaisala-radarsw-geoserver

7.8 Data Manager

Data manager is the HTTP/REST interface that provides raw data for live radar products.
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Table 10 Data Manager Services

Service Description

vaisala-radarsw-data-manager Listener.
vaisala-radarsw-data-manager- HTTP server for live radar products that are
input-service queried from the IRIS Focus web application.

More Information

» Live Radar Products (page 84)

7.9 Stopping, Starting, and Restarting Services

In CentOS 7, services are stopped, started, and restarted with the service
[servicename] stop / start / restartcommand.

To use the service command, you must be a logged in as the root user.
The following example shows how to stop, start and restart the IRIS Focus web application
service. Note that the Monit service starts along with the web application.
Stopping the service
* service monit stop
* service vaisala-radarsw-webapp stop
Starting the service
* service vaisala-radarsw-webapp start
* service monit start
Restarting the service

* service vaisala-radarsw-webapp restart

710 Logging

IRIS Focus log files are stored in directory /var/log/vaisala/radarsw/webapp, which
contains:

 Application error log: webapp . log
* Information about application performance: webapp-metrics. log

Older logs are rolled over to separate files and zipped automatically in . gz files. No log files
are deleted automatically.
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The logging configuration file is in /etc/vaisala/radarsw/configuration/
logback. xml.

7.10.1 Reading System Service Logs

When diagnosing issues with the IRIS Focus server, you may need to access the log files from
system services using the CentOS 7 Journal tool:

journalctl -u [service-name] -1 -f --no-pager
Some useful options for journalctl are:

» —u for showing log entries for a given service

* —n for showing only a given number of recent log lines

« —f for following new log entries being logged

* ——no-pager for not using a pager program such as less for the output
» =1 to print out full log lines and not ellipsize (shorten) them.

For more information, type man journalctlin CentOS 7, or Using the Journal at RHEL
System Administrators Guide (https://access.redhat.com/documentation/en-US/
Red_Hat_Enterprise_Linux/7/html/System_Administrators_Guide/s1-
Using_the_Journal.html)

7.10.2 Reading Nowcast Server Logs

The nowcast server logs are useful when diagnosing issues with the nowcast server.

p 1. Check the status of the nowcast server by typing:

service vaisala-radarsw-nowcast-server status

2. Check the logs by typing:

journalctl -f

711 Installing a CA Certificate

The web application comes with a temporary, self-signed SSL certificate that secures the
connection between the IRIS Focus server and the user's web browser.

Consider acquiring and using a trusted certificate from a certificate authority (CA), especially
if you plan to offer access to IRIS Focus outside your organization.

p 1. Acquire a certificate that has been signed by a trusted authority
This is usually done by an IT department or an external organization, who purchase the
certificate from an external certificate authority (CA).
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2. Back-up your current configuration by running:
run /usr/vaisala/radarsw/backup/bin/do-backups
This backs up all the configuration files as a . tar fileto /srv/vaisala/radarsw/

backup/configuration.

3. Go to the default certificate folder:
/etc/vaisala/radarsw/webapp-proxy/certificates/cert.pem

a. Back up the file locally by running:

cp /etc/vaisala/radarsw/webapp-proxy/certificates/cert.pem /etc/vaisala/
radarsw/webapp-proxy/certificates/cert.pem.bkp

b. Replace the certificate in the file with the new, signed certificate.

More Information

»  Web Application (page 88)
»  Certificates (page 89)

712 Backing-up System Configuration

IRIS Focus is backed up automatically using a daily configuration and database backup job
that are run at 02:30 AM server time. On factory settings, the server uses UTC as the time
zone.

Automatic Back-up

Backup is done by the cron job /etc/cron.d/vaisala-radarsw-backup-cron that
launches the /usr/vaisala/radarsw/backup/bin/do-backups script.

The backup script stores the server configuration and application settings database. The
created backup files are zipped and stored in the following directories:

* /srv/vaisala/radarsw/backup/configuration
* /srv/vaisala/radarsw/backup/database

Backups are kept for 180 days, after which they are deleted. Each backup file includes a
timestamp in the format: radarsw-configuration-2015-09-21 02-30-01.tar.gz

7.12.1 Making a Manual Back-up

p 1 Loginasroot.

2. Run: /usr/vaisala/radarsw/backup/bin/do-backups
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3. Check that new files are created in the following directories:
* /srv/vaisala/radarsw/backup/configuration/radarsw-
configuration-<timestamp>.tar.gz
* /srv/vaisala/radarsw/backup/database/database-<timestamp>.gz

713 Restoring from Backup

1. Login as root.

2. Stop the Monit service:

service monit stop

3. Stop the IRIS Focus web application:

service vaisala-radarsw-webapp stop

4. Take a backup of the current configuration:

/usr/vaisala/radarsw/backup/bin/do-backups

5. Drop the current database with the rsw-db-tool utility:

rsw-db-tool drop-db

6. Recreate an empty database:

rsw-db-tool create-db

7. Switch to the database user account postgres:

su - postgres

8. Restore the database contents from a backup file by reading the file contents into the
standard output stream and inserting them in the IRIS Focus database wxdb2:

gzip --decompress --to-stdout /srv/vaisala/radarsw/backup/database/
database-<timestamp>.gz | psql --set ON_ERROR_STOP=on --single-transaction
wxdb2

9. Exit the postgres user shell:

exit
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10. Start the IRIS Focus web application and Monit service:

service vaisala-radarsw-webapp
start service monit start

714 Server Management Software

If you are running server management software on your IRIS Focus server, make sure the
management software's settings do not interfere with your intended network settings.

For example, in Dell PowerEdge servers, the integrated Dell Remote Access Controller (iDrac)
sets a default static IP address for the server when it is first deployed.

On Vaisala preconfigured IRIS Focus systems, iDrac is disabled by default.

715 Licensing on Server Restart

Active sessions and their licenses are not stored when the IRIS Focus server is shut down.
When the server restarts, the licensing seats are allocated from scratch to users who log in.
The total number of seats in the license pool is unaffected.

More Information

» Licensing (page 9)

716 Licensing on Systems with Mirrored HDDs
(RAID 1T or RAID 5)

IRIS Focus licenses are mapped, among other parameters, to hard disk IDs. Removing or
replacing one hard disk in a RAID array can cause unexpected behavior, and you should renew
your license as a precaution when doing so. Contact your Vaisala customer representatives for
further instructions.

More Information

» Licensing (page 9)
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717 Reactivating the License After Server
Upgrade

The product key in the IRIS Focus license is server-specific. If you upgrade your server, you
must request a new service key and activate the new license.
p 1. Contact Vaisala and request a new server key.
2. Set-up your new server by performing the steps in the following sections:

a. Installing CentOS (page 16).
b. Installing IRIS Focus Components (page 26).
c¢. Setting up Data Manager (page 30).
d. Verifying IRIS Focus Installation (page 34).

3. Reactivate the license.
Depending upon whether or not your server is connected to the internet, see:
» Activating License - Online (page 34)
* Activating License - Offline (page 36)
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8. Troubleshooting

8.1 Lightning Layer Empty

If the lightning layer exists in your IRIS Focus application but you do not see any lightning
strikes, verify the following requirements:

p 1. Check that lightning strikes have occurred at the time of observation

2. Check that the configuration file /etc/vaisala/radarsw/configuration/
vsoweb-override. ini contains the following line:

lightning.wms.url = [URL received from Vaisala]

3. Check that your subscription to Vaisala AviCast GLD360 service is active

If you modify the configuration file, you must restart the vaisala-radarsw-
webapp service with the service vaisala-radarsw-webapp
restart command.

8.2 Lightning Layer Missing

If you have subscribed to Vaisala AviCast GLD360 lightning detection service, and you do not
see the lightning layer in the IRIS Focus user interface after running the rsw-1lightning-
configure script, add the lightning layer manually.
p 1. Loginto IRIS Focus with an administrator account and select Admin.
2. Select Map > Map Layers.
3. Select Add New Layer.
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4. In Map Layer Information, enter the following values on the layer properties:

5.

M211850EN-E

Edit Map Layer x

Map Layer Information

Title Lightning

URL € /lightning

Layer lightning:Itg_combined_25
Base layer [}
Transparent

MIME type image/png .

Layer Style

Append SLD to request B

SLD URL @ |https://storm.vaisala.com/geolegends/ltg_combined 25.sld

Name @ |tg_combined_25,Itg_types

Save

Cancel

T o

C.
d.

e.

. URL: /lightning
. Layer: lightning:1ltg_combined_25

Transparent: Checkbox selected
SLD URL: https://storm.vaisala.com/geolegends/Itg_combined_25.sld
Name: 1tg_combined_25.1tg_type

Select Save.

6. Select Map > Map View Contexts
7. Edit the default map context TheMap.
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8. Select the newly created lightning layer and set its Z level higher than all base map layers
in the map context.
Z leveldefines the drawing order of the layers on the map. Higher values are always drawn

on top.

Map View Context Information

Layers
Search

Selected A Title Layer group Second level layer group Visible Z level

v baseLayerTerrain Base Map ’ 2 -
v full Base Map v 7

e general Base Map o 6

I o

v minimal Base Map ¢ 3

=2 roads Base Map v 4

Selected layer Lightning
Z level 9

Cancel

In the web application, the new layer is listed at the bottom of the radar product selection list.

8.3 Nowcasting is Unavailable

If you cannot see nowcasting features on your display, it is likely because you either do not
have a license or because nowcasting is disabled.
p 1. Check that you have a nowcasting license.

a. You must have an IRIS Focus seat to use nowcasting. If you see the IRIS Vision display,
wait until an IRIS Focus seat is available and try again.
See Licensing (page 9).

b. Login to IRIS Focus as an administrator.
c. Select Admin > Licensing Management.

2. Check that MVF is configured for your site.
See Configuring MVF (page 43).

3. Login as root.

4. Goto /etc/vaisala/radarsw/configuration/vsoweb-override. int.
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5. Inthe [NOWCAST] section of the vsoweb-override.ini file, check that MVF creation
is enabled in IRIS Focus:

[NOWCAST]
nowcast.mvf.run = true

0 By default, MVF generation is enabled (true).

6. Restart the vaisala-radarsw-webapp service by typing:

service vaisala-radarsw-webapp restart

7. Start the nowcast server by typing:

service vaisala-radarsw-nowcast-server start

a. To verify that the server starts, type:

systemctl status vaisala-radarsw-nowcast-server.service

b. Check for the status:

Active: active (running)

8.4 Taking a Snapshot Gives Server Error

If, when taking a snapshot or requesting an image via URL, the server times out or gives server
error, there may be a problem with the image-export user account.

p 1. Check that the application log shows the error:
Login failed for username image-export
2. Login as admin.

3. Check that the image-export user password matches the password listed in vsoweb-
override.int.
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8.5 Online Help Does Not Display Correctly in
Internet Explorer

If you run the software in Internet Explorer with the compatibility view enabled, the online help

may not display correctly.

To fix the problem, turn off the Display intranet sites in Compatibility view setting.

p 1. Todisplay the Internet Explorer menu, press ALT.
2. Select Tools > Compatibility View settings.
3. Deslect Display intranet sites in Compatibility view.
4. You may need manage the list under Websites you've added to Compatibility View:
a. Highlight the website address you want to remove.
b. Select Remove.

8.6 Uninstalling IRIS Focus

Use this procedure to recover from a failed installation that is stuck in a state where it cannot
be resumed.

CAUTION! The rsw-uninstaller script completely removes IRIS Focus,

! including all data and configurations.
CAUTION! The rsw-uninstaller script removes Postgres and all
! databases.

If you share the system with other software that uses PostgreSQL, do not run
the script -- it also removes PostgreSQL databases not related to IRIS Focus.

p 1. Navigate to the directory containing the IRIS Focus installation files.

2. Run: . /rsw-uninstaller
When prompted, confirm that you want to run the script.
The script removes all users, configurations, and data from the system so that you can
rerun the installation.

More Information

» Installing IRIS Focus Components (page 26)
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9. IRIS Focus Architecture

IRIS Focus reads data in the formats produced by weather radar signal processors.

Usually this data is relayed to IRIS Focus through the signal processing and analysis
component, IRIS Analysis, either as pregenerated radar products or as radar scan source data
files which are processed and displayed as radar products by IRIS Focus.

IRIS Focus only accepts a single data source as its socket server. IRIS Analysis can be
connected to an unlimited number of radar sites and relay their radar products to IRIS Focus.

Radar scan
database
Raw data File access PPI, CAPPI_| Web Ul
|R|S € Data Manager| ¢ == :
Controls o R
o h;
backend e e
Radar products N IRIS Socket adar products N ! H.\\
Server
Requests

Figure 12 IRIS Focus Architecture

Each radar product is displayed on top of a map view, which is rendered by a GeoServer
instance that is installed during the IRIS Focus installation. The map terrain and detail layers
are always on the background, and the radar products are drawn on top of them. The user can
change the order of radar product layers in real-time.

Most radar products have editable color scales. Color scales are stored as JSON objects on the
IRIS Focus server and can be reused.

9.1 Map Layers

The background map and the weather data visualizations from the radar products are drawn
as individual layers and then combined to form an overview of current weather conditions
around the radar site.
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Figure 13  IRIS Focus Product Data Layers

Base Layers

The background (also known as base) consists of a number of non-interactive layers. At the
bottom is a terrain map that can be enhanced with additional layers containing roads, province
boundaries, and other similar terrain features.

Radar Product Layers

The interactive radar product layers (1to 4) are drawn on top of the background layers.

9.2 GeoServer and Maps

The map engine in IRIS Focus uses GeoServer architecture. When reading data from a single
radar site, GeoServer renders the map using Azimuthal Equidistant projection, which means
that all directions and distances are correct when measured from the point of origin, which is
the radar site in this case. When reading data from a composite of multiple radar sites, Web
Mercator projection is used.

The terrain data in IRIS Focus consists of a detailed vector map of Earth, separated into
multiple layers. The base map content is licensed from the collaborative OpenStreetMap
project, which provides all vector shapefiles for the base terrain.
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Figure 14 Base Map From GeoServer

To save system resources, the shapefiles are combined into different map detail levels that are
rendered as a single layer where possible. For example, selecting the Full detail map level does
not draw separate layers for terrain, roads, map labels, and other map features. Instead, all the
content has been precompiled into a single layer in the IRIS Focus map package and then
drawn on screen.

When a user opens the map view in IRIS Focus, GeoServer processes the vector data in the
current view area into 256x256 PNG tiles that are displayed in the browser window. New tiles
are calculated and generated every time the user pans or zooms on the map, so moving on the
map may feel a bit sluggish in the beginning. To improve performance, GeoServer runs a
caching component called GeoWebCache that stores the tiles for faster retrieval in the future.

GeoServer has a management web interface that runs at http://localhost:34180/
geoserver. The default management account name is admin and the password can be found
inthe file /etc/vaisala/radarsw/configuration/gis-override.ini.The
password is generated automatically during IRIS Focus installation.

The base map data is stored in a postgreSQL database, which also stores all web application
data.

9.3 Live Radar Products

When displaying live radar products, IRIS Focus fetches raw radar measurement data from the
back-end and processes it in real-time. This provides hands-on control over the radar product
parameters.

The full raw radar volume data is stored for 48 hours and can be used for on-demand product
generation later.
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Figure 15 Live Product Components

Data for live products comes from the RAW format files produced by the IRIS backend.

IRIS Focus reads the RAW data through the data manager.

When you select a live radar product in IRIS Focus, the web application accesses the database
and fetches the required data, not only for the current situation but for the whole recorded
segment up to 48 hours. The data is then processed live in IRIS Focus and can be animated
similarly to pregenerated radar products.

Figure 16  Radar Product Visualized

More Information

» Data Manager (page 70)
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9.4 Pre-configured Radar Products

Pre-configured radar products are generated by the back-end signal processing components
of IRIS Analysis. IRIS Focus reads the list of products, and allows you to select which one to
display on the IRIS Focus map view.

The radar products and their settings are defined in the back-end, and only displayed in IRIS
Focus. They cannot be edited in the IRIS Focus map view.

There is no upper limit to the number of pre-configured radar products that IRIS Focus can
have.

The raw volume data is not stored for later processing. All the information that is not used in
radar product generation is lost.

Radar scan
database
Raw data File access . PPI.CAPPI) Web UI
&
IRIS manager [& —Sri ctem—
Controls = LL
backend S
ac en Radar products .I T
Rad ducts P L 4
adarproducts | RIS Socket 3| |- B
Server Requests

Figure 17 Pre-configured Radar Product Components

The radar products are rasterized into 2D bitmap images, based on the back-end signal
processing settings. The images are sent to IRIS Focus web Ul through the IRIS Socket Server
interface. The Socket Server uses TCP port 30735 to communicate with IRIS Focus.

When you select a specific pre-configured product in IRIS Focus, IRIS Focus polls the Socket
Server and loads the image.

The resolution of pre-configured radar products is limited by the capacity of the processing
module that produces them. For example, IRIS Analysis has the following limitations:

* Max number of bins in any ray at any time: 4200
* Max number of rays in a sweep: 1024
* Max number of moments recorded in a sweep: 16
* Max number of sweeps per scan: 40
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Figure 18 Live and Pre-configured Product Settings

9.5 Lightning Layer

Vaisala offers an optional subscription service for the Vaisala Global Lightning Dataset
GLD360. GLD360 is a dedicated data stream that measures lightning strikes from the surface
of the Earth, and its data is generated outside IRIS Focus.

GLD360 can be integrated with IRIS Focus and included as an additional selectable lightning

layer in the web Ul. From the user's perspective, the lightning layer is similar to other weather
product layers.
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Figure 19 Lightning Layer and Controls
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To take the lightning layer into use, IRIS Focus server must be online and your organization
must have an active subscription for GLD360. For information on subscribing to the GLD360,
contact Vaisala Lightning Data Services.

p 1. Logon to the IRIS Focus server as root.

2. Type the command
rsw-lightning-configure -r [admin username] -p [admin password]
-s https://storm.vaisala.com/geolegends/ltg_combined_25.sld

3. Edit the configuration file vsoweb-override.ini:nano /etc/vaisala/
radarsw/configuration/vsoweb-override. ini to contain a reference to the
Vaisala GLD360 URL you received:

lightning.wms.url = [URL from GLD360]

4. Restart the IRIS Focus web application service:
service vaisala-radarsw-webapp restart

9.6 Web Application

The IRIS Focus web application can be accessed with current Internet Explorer, Mozilla Firefox,
and Google Chrome browsers.

It only accepts HTTPS connections. All requests to the standard HTTP port are redirected to
the HTTPS port 443.

All application settings are stored in a PostgreSQL database on the IRIS Focus server.

Map and terrain data are stored in the same database.

More Information

» Certificates (page 89)
» Encryption (page 89)
» Installing a CA Certificate (page 72)
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10. Security

10.1 Encryption

Communication between the browser and the web application is encrypted.

Other data traffic within the IRIS Focus application server is unencrypted.

IRIS Focus uses Jetty as web server software, and HAProxy for handling HTTPS encryption.
SSL encryption has been disabled in HAProxy, and only TLS encryption is supported.

More Information

»  Web Application (page 88)
»  HAProxy (page 70)

10.2 Certificates

The web application comes with a temporary, self-signed SSL certificate that secures the
connection between the IRIS Focus server and the user's web browser.

Although the browser displays a security warning in the browser when you try to access the
web application, you can use the application normally even with the warning.

Consider acquiring and using a trusted certificate from a certificate authority (CA), especially
if you plan to offer access to IRIS Focus outside your organization.
More Information

»  Web Application (page 88)
» Installing a CA Certificate (page 72)

10.3 Security Settings

The IRIS Focus server has a pre-configured firewall.
Ports for SSH access (22), HTTP (80), and HTTPS (443) are intentionally open:

» Use SSH for configuration
* HTTP port is for redirecting to HTTPS
The application is always used over HTTPS

The server requires access to HTTP and HTTPS for end users. If the system is accessed through
the internet, you should restrict internet access to the SSH port from the internet to improve
system security.
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The firewall is configured through the CentOS firewall system. See https://access.redhat.com/
documentation/en-US/Red_Hat_Enterprise_Linux/7/html/Security_Guide/sec-
Using_Firewalls.html.

More Information

» Installing IRIS Focus Components (page 26)
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Appendix A. File Locations

Table 11

IRIS Focus Application and Configuration Files

File or Directory Description

/etc/vaisala/radarsw/
configuration

* gis-override.ini

GeoServer database settings.
* logback.xml

Logging level settings.
* radar_centers.properties

List of stored radar site center points.

Configuration files for IRIS Focus module settings.
The files listed here are the most important.

CAUTION! Some settings have a
default config file and an override
file. For example:

* gis-config.ini
e gis-override.ini

When needed, edit the override file.

/etc/vaisala/radarsw/
configuration/vsoweb-
override.ini

Connection settings for socket server, lightning
layers, nowcasting and so on.

/etc/vaisala/radarsw/nowcast/
nowcast. ini

Configuration files for the nowcast server.

Jusr/vaisala/radarsw/

Configuration files for helper applications used in

configuration IRIS Focus maintenance.
/var/lib/radarweb Home directory of the radarweb user.

The IRIS Focus Web Application is deployed here.
/var/lib/radardm Home directory of the radardm user.

/var/lib/radardminput

Home directory of the radardminput user.

/srv/vaisala/radarsw/
datamanager/input

Files sent from an IRIS Analysis machine are copied
here.

The data manager input service processes files
copied here.

/srv/vaisala/radarsw/
datamanager/storage

This is where data manager stores polar or RAW data.

/var/lib/warnreader

Configuration files for events and alerts.

/var/log/vaisala/radarsw

Log files from IRIS Focus web application

91



Version 4.0 Administrator Guide

Appendix B. Map Layer Configuration

Options

Table 12 Map Layer Configuration Options

Option

Map Layer Information

Description

Defines basic map settings such as the title and the
URL address of the Web Map Service (WMS).

WMS Layer Only

Title Title of the layer. Visible in the Layer Selector -
Type « wms: generic GIS services such as base maps or --
raster-type forecast data
* google: Google base maps.
* marker: observations from stations configured
using the JX source service on the map.
URL Address of the WMS service. v
Layer Name of the layer in the map server. -
If using GeoServer, usually workspace: layer.
Base layer Select if the layer is a base map. -
Transparent Select for WMS to request a transparent 2V 4

background for the layer.

Request as Tiles

Use if the map layer should be requested as tiles.
Usually selected for base maps.

MIME type

Map image type. Change if the service does not
support the default image/png.

Default opacity

Layer query settings

e Not used in IRIS Focus.

Supported
Coordinate Reference
Systems

Select supported coordinate reference systems for
the layer.

Time Support

Configure for layers using time dimensions.

Coverage

Maximum bounding box for the layer.

Layer style

For advanced configurations, add SLD (Styled
Layer Descriptor) parameters.

More Information

»  Working with Map Layers (page 67)
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Appendix C. Nowcasting Configuration
Files

C.1. nowcast.ini

The following example shows the nowcast. ini configuration file for configuring the
nowcasting HTTP server.

5 Algorithm to use.
correlator=trec

TREC

[trec]

5 Number of decimals to keep 1in data when converting to dintegers.
5 Range: [0 ; 3]. Default: 2.

input_precision=2

5 The value in image that declares a missing/invalid value.
; Default: -999.0.
missing_value=-999.0

5 The value in image that declares a not-scanned pixel, outside the aperture
area.

; Default: -900.0.

not_scanned_value=-900.0

5 Minimum measurement aperture coverage (%) 1in correlation region.
5 Range: [0.0 ; 1.0]. Default: 0.60.
aperture_coverage_threshold=0.60

5 Minimum signal value for the pixel to be 'active' and used.
; Default: 10.0.
signal_threshold=10.0

; Feature box size.
; Range: > 0 Default: 14
field_feature_box_width=14

5 Amount of skip when calculating field values.
; Range: > 0. Default: 1 (no skip).
field_feature_box_spacing=1
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3 Minimum fraction (%) of active pixels 1in feature box needed to trigger
correlation analysis.

;5 Range: [0.0 ; 1.0] Default: 0.10

field_signal_coverage_threshold=0.10

3 Minimum allowable cross-correlation coefficient.
; Range: [0.0 ; 1.0] Default: 0.55
correlation_threshold=0.55

5 Maximum storm movement between images, search region radius.
; Range: > 0 Default: 15
speed_limit=15

; Spatial smoothing factor, exp(-d/decay). Used for spreading effect
; of local motion vector to its surroundings.

; Range: >= 0 (0 == no spatial smoothing) Default: 6
field_spatial_decay=6

; Spatial filtering flag. Whether to discard points that differ from global
average.

;5 Range: 0 == NO; 1 == GLOBAL; 2 == LOCAL . Default: 1(GLOBAL)
field_use_spatial_filtering=1

; Feature box size for local spatial thresholding (applied only when using
local spatial thresholding).

;5 Range: > 0 Default: 9

field_spatial_filtering_box_width=9

3 Maximum allowed direction difference from mean motion (applied only when
using spatial filtering).

; Range: [0 ; 180] Default: 90

field_spatial_direction_threshold=90

3 Maximum allowed speed (mgtxmean_motion) above mean motion (applied only when
using global spatial filtering).

; Range: >= 1.0 Default: 3.0

field_spatial_magnitude_threshold=3.0

; Global vector weight applied to local values.
;5 Range: [0.0 ; 1.0] (0.0 = no global weighting). Default: 0.25
field_global_weight=0.25

3 Method for temporal smoothing.

; Range: 0 == NO_TEMPORAL_SMOOTHING; 1 == HISTORY_WEIGHTING; 2 ==
CHANGE_WEIGHTING.

; Default: 1(HISTORY_WEIGHTING)

temporal_smoothing_method=1
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; History weight factor (applied when temporal smoothing is made by using
HISTORY_WEIGHTING) .

5 Range: 10.0 ; 1.0] Default: 0.25
temporal_smoothing_history_weight=0.25

5 Change weight factor (applied when temporal smoothing is made by using
CHANGE_WEIGHTING) .

; Range: ]0.0 ; 1.0] Default: 0.33
temporal_smoothing_change_weight=0.33

More Information

»  Configuring Nowcasting (page 43)

C.2. vsoweb-override.ini

The vsoweb-override. ini configuration file contains setting for managing the MVF and
advection used in nowcasting.

The raster product, such as PPI, CAPPI, of any intensity moments like Z, R, KDP, or

0 Vaisala has carefully chosen good defaults for the nowcasting configuration.
rhoHV that is used as an input for MVF generation should have:

 As little as possible of ground clutter and the near-radar clear air or
particulates (such as dust) returns.
* The bounding box not smaller than any other raster product produced from
this site's data.
Because the two conditions are contradictory, the easiest way to satisfy first
condition is to use a true (not pseudo) CAPPI product with a height of 1.5 ... 2km,
but the longest range (biggest bounding box) product is a raster product
generated from the survey scans, which usually consist of just one PPl scan and
cannot be used to generate true CAPPI products. You must balance these two
conditions.

If there are not enough valid products to generate an MVF request, the iteration is
skipped and the system waits for the next product to arrive from IRIS.

Basic Settings

nowcast.mvf.run defines if MVF generation is enabled in IRIS Focus. By default, MVF
generation is enabled (true).

[NOWCAST]
nowcast.mvf.run = true
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The nowcast server URL defines identifies where the nowcast HTTP server runs. The default
value is for a fully local installation, which is the default installation configuration.

nowcast.http.server.url = http://localhost:34480/api/vl/mvf/

The netCDF directory stores MVF generation requests and responses to the Nowcast HTTP
Server in netCDF format as well as internal representations of MVF serialized to disk. This
directory is cleaned periodically by default.

nowcast.netcdf.dir = /srv/vaisala/radarsw/product/nowcast/

Advanced Settings

nowcast.mvf.request.num.rasters defines the number of products sent to the
nowcast server for generating the motion vector field (MVF). Default is 2.

nowcast.mvf.request.num.rasters = 2

nowcast.mvf.product.age.limit.minutes defines the maximum number of minutes
(5...1000) the system goes back in time to find valid products (of the type used to define MVF
generation for a site) to use in generating the MVF. Default is 100.

nowcast.mvf.product.age.limit.minutes = 100

nowcast.mvf.max.gap.minutes defines the maximum acceptable gap in minutes
(1...1000) between products for MVF generation. Default is 30.

MVF is a shift in pixels per time interval between frames of the product which was used to
generate MVF. The interval between advected products could easily be different from the
interval between advected frames. For example, if MVF was generated from the product which
was available every 5 minutes but the interval between advected frames has to me 10 minutes,
the MVF shift should be doubled. That MVF scaling is taken into account by scaling shift in
every iteration.

nowcast.mvf.max.gap.minutes = 30
nowcast.product.times.age.limit.minutes defines the time range for calculating
advected product times (2 ... 2880 mininutes. 2880 is the entire two day range). Default is 100

Advected product times must be evenly spaced (due to the calculation). The time is derived by
dividing the last number of minutes defined in this property by n products found in that
period.

The spacing is used as the time gap between advected products. In most cases, you should set
this value to match the value in nowcast.mvf.product.age.limit.minutes.

nowcast.product.times.age.limit.minutes = 100
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nowcast.advection.mvf.age.limit.minutes is the maximum number of minutes to
go back in time to find an MVF when generating advected products. If an MVF is not found in
the time span given, the iteration is skipped and Focus waits for the next product to arrive
from IRIS. Range: 5 ... 1000 minutes. Default is 30.

nowcast.advection.mvf.age.limit.minutes=30

nowcast.advection.time.span.minutes defines the time limit when extending
nowcasted products into the future, in minutes. The normal range is 1... 3 hours. Default is 120.

You can raise the time span to as much as 6 hours but this is not recommended as accuracy
becomes more vague as time is extended into the future.

nowcast.advection.time.span.minutes=120

More Information

»  Configuring MVF (page 43)
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Glossary

advection
The transfer of a property of the atmosphere, such as heat, cold, or humidity, by the
horizontal movement of an air mass. Advection calculations are used to perform some of
the nowcasting calculations.

alarm
An alarm is an alert of highest severity.

alert
Alert is a state that requires user intervention or recognition. Different types of alerts
include alarms, warning, and informational alerts.

bin
A single sample of weather data detected at a known direction, altitude, and distance
from the radar site. The radial size of a bin depends on decreases with distance, so bins
further from the radar site cover a larger area than nearby bins.

event
Event is a record of a momentary change of state or an occurrence produced by a source
or some other entity. An event can indicate an error or a warning or can be just for
information.

hydrometeor
A particle of condensed water vapor in the atmosphere. Rain, snow, and hail are
examples of hydrometeors.

Max Time Span
Max Time Span is the maximum time (minutes) allowed between the newest and oldest
points of data. When new data is processed, points that are older than the specified time
span are removed. Used in, for example, composites of radar data.

MSL
Mean sea level. An average level for the surface of the sea or ocean.

NDOP product
Dual-Doppler velocity product. Combines the velocity measurements from 2 or more
radars to get the wind direction and speed.

nowcasting
Weather forecasting up to the next 2 hours.

NWP
Numerical weather prediction

PRF
Pulse Repetition Frequency measured in Hz (pulses per second). When measuring PRF, a
pulse contains transmit, receive, and dead time phases. PRF affects range folding and
velocity folding detection. Normal PRF values for Doppler radars are up to 1000 Hz.
Vaisala radars generally operate around 400-700 Hz. In Vaisala IRIS products, PRF limits
the area displayed in radar images and the maximum measurable wind speed.
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pulse
A short burst transmission signal sent by the radar, used to measure the weather activity
in atmosphere. The reflection measurements from a pulse are sorted into bins.

range folding
Radar signal echoes from outside the radar maximum range that are incorrectly
displayed within the radar measurement area. Also called range aliasing.

RAW product
Spherical coordinate data product obtained directly from the raw ingest data. The data
are stored in compressed format so they can be recorded on tape or sent to a
workstation for further processing.

sweep
A collection of pulses at a constant elevation as the radar rotates around its axis 360°.
After a sweep, the radar usually changes its elevation and starts a new sweep. Each
sweep typically contains the same number of bins independent of the elevation.

task
A set of instructions to the radar and signal processing systems including, but not limited
to, the scan type (PPI or RHI), PRF, pulse width, signal processing data types, time and
range averaging criteria. For example, a PPl volume scan at multiple elevation angles or
an RHI at a single azimuth. Also called radar task.

velocity folding
Erroneous readings due to particles in the measurement area exceeding the maximum
velocity detection threshold of the radar system. The measured velocity "wraps around”
to the other end of the scale, resulting in discontinuous readings. Also called velocity
aliasing.

volume
Complete set of raw measurement data collected from sweeps, that is used to calculate a
model of the atmosphere. The maximum volume is half of a sphere (from 0° elevation
upwards), but other shapes are more typical.

warning
A warning is an alert of medium severity.
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Warranty

For standard warranty terms and conditions, see www.vaisala.com/warranty.

Please observe that any such warranty may not be valid in case of damage due to normal wear
and tear, exceptional operating conditions, negligent handling or installation, or unauthorized
modifications. Please see the applicable supply contract or Conditions of Sale for details of the

warranty for each product.
Technical Support

Contact Vaisala technical support at helpdesk@vaisala.com. Provide at least the
following supporting information:

* Product name, model, and serial number

* Name and location of the installation site

* Name and contact information of a technical person who can provide further
information on the problem

For more information, see www.vaisala.com/support.
Recycling
&% Recycle all applicable material.

LT

ﬁ Follow the statutory regulations for disposing of the product and packaging.
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